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1 
                                          PREPARED BY…  B.MOHAMED YOUSUF   M.C.A.., B.Ed.,   (PG ASST IN COMPUTER SCIENCE) 

                                          [yousufaslan5855@gmail.com] 

CHAPTER 1 TO 18 ONE WORD PUBLIC QUESTION with ANSWERS [MARCH-2019 TO JULY-2024] 
(CHAPTER-1) (Introduction to Computers) 

1. First generation computers used --- [S-2022, J-2024] 

(a)Vacuum tubes    (b) Transistors   (c) Integrated circuits   (d) Microprocessors 

2. Name the volatile memory---- [M-2022] 

(a) ROM     (b) PROM    (c) RAM    (d) EPROM 

3. Identify the input device [J-2019] 

(a) Printer     (b) Mouse    (c) Plotter    (d) Projector 

4. In ATM machines, which one of the following is used to ------ [S-2020] 

(a) Touch Screen    (b) speaker    (c) Monitor   (d) Printer 

5. When a system restarts ………………..which type of booting is used.  [M-2019, M-2023] 

(a) Warm booting   (b) Cold booting    (c) Touch boot   (d) Real boot 

6. Expand POST [J-2023] 

(a) Post on self-test             (b) Power on Software Test (c) Power on Self-Test   (d) Power on Self Text 

7. Which one of the following is the main memory? [M-2024] 

(a) ROM     (b) RAM   (c) Flash drive    (d) Hard disk 

8. Which generation of computer used IC’s? [S-2021] 

      (a) First    (b) Second    (c) Third   (d) Fourth 

(CHAPTER-2) (Number Systems)  
1. Expansion for ASCII [J-2024]         (a) American School Code for Information Interchange.  

(b) American Standard Code for Information Interchange 

(c) All Standard Code for Information Interchange (d) American Society Code for Information Interchange 

2. For 11012 what is the Hexadecimal equivalent? [M-2022] 

(a) F    (b) E    (c) D    (d) B 

3. What is the 1’s complement of 00100110? [M-2023] 

(a) 00100110   (b) 11011001   (c) 11010001   (d) 00101001 

4. For 11102 the hexadecimal equivalent is: [J-2023] 

(a) C   (b) B   (c) E   (d) A 

5. How many bits are there in Nibble? [J-2019]  

     (a) 2    (b) 4   (c) 8   (d) 1024 

6. What is the 1’s complement of 11011001? [S-2020] 

(a) 00100110   (b) 11100110   (c) 11011000  (d) 11011111 

7. 2^30 is referred as [M-2019] 

(a) Peta    (b) Mega   (c) Giga   (d) Tera 

(CHAPTER-3) (Computer Organization) 

1. Which of the following is not the part of a microprocessor unit? [J-2019] 

       (a) ALU    (b) Control unit    (c) Cache memory  (d) register 

2. How many bits constitute a word? [J-2024]       

      (a) 8    (b) 16       (c) 32     (d) determined by the processor used 

3. Which of the following is a CISC processor? [M-2020] 

       (a) Intel P6     (b) AMD K6     (c) Pentium III    (d) Pentium IV 

4. What is the smallest size of data represented in a CD? [M-2023] 

       (a) Blocks    (b) sectors   (c) pits    (d) tracks 

5.  Display devices are connected to the computer through. [M-2019] 

       (a) USB port    (b) Ps/2 port    (c) SCSI port      (d) VGA connector 

6. Which of the following is a RISC processor? [M-2024] 

       (a) Pentium III   (b) Pentium IV    (c) Intel 386    (d) Pentium II 

(CHAPTER-4) (Theoretical concepts of Operating System) 
1. Operating system is a -------- [M-2019, J-2024] 

(a) Application Software   (b) Hardware   ` (c) System Software    (d) Component 

2. Which of the following is not a function of an Operating System? [M-2023] 
(a) Process Management  (b) Memory Management  (c) Security management  (d) Complier Environment 

3. Which of the following Operating systems support Mobile Devices? [S-2020, S-2021] 

(a) Windows 7    (b) Linux    (c) BOSS    (d) iOS 

4. File Management manages [M-2022] 

(a) Files    (b) Folders   (c) Directory systems  (d) All the Above 
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2 
                                          PREPARED BY…  B.MOHAMED YOUSUF   M.C.A.., B.Ed.,   (PG ASST IN COMPUTER SCIENCE) 

                                          [yousufaslan5855@gmail.com] 

5. The File management system used by Linux is [S-2022, M-2024] 

(a) ext2    (b) NTFS   (c) FAT    (d) NFTS 

6. Android is a ---- [J-2019] 

(a) Mobile O.S  (b) Open source  (c) Developed by google (d) All the above 

(CHAPTER-5) (Working with typical operating systems) 
1. From the options given below, choose the operations managed by the operating system. [S-2021] 

          (a) Memory      (b) Processor        (c) I/O devices      (d) all of the above 

2. Which is the default folder for many Windows Applications to save your file? [M-2020] 

 (a)  My Document    (b) My Pictures    (c) Documents and Settings    (d) My Computer 

3. The shortcut key used to rename a file in windows [S-2021, M-2023, J-2023] 

 (a) F2    (b) F4    (c) F5    (d) F6 

(CHAPTER-6) (Office Automation Tools - Word Processor) 
1. Which menu contains the numbering option? [M-2024] 

(a) File    (b) Edit    (c) Tools   (d) Format 

2. Which is displayed at the top most part of the window? [M-2019, M-2022] 

 (a) Menu bar   (b) Tool bar    (c) Title bar    (d) Format bar 

3. The Find & Replace option is available in which menu? [J-2019, M-2022, J-2024] 

(a) File    (b) Edit    (c) Format   (d) Tools 

4. Which button selects all instances of the search text in the document? [S-2022] 

(a) Find    (b) Find All   (c) Replace   (d) Replace All 

5. What is the short cut key for Undo? [M-2023, J-2024] 

 (a) Ctrl +E    (b) Ctrl + U   (c) Ctrl + Z   (d) Ctrl + N 

6. What is the shortcut key to go to the beginning of the line? [J-2023] 

(a) Ctrl + Home   (b) Ctrl + End   (c) Home   (d) End 

(CHAPTER-7) (Office Automation Tools - Working with Open Office Calc) 
1. Which is the first electronic spreadsheet?  [J-2019, M-2020, S-2020] 

            (a)Excel    (b) Lotus 1-2-3    (c) Visicalc   (d) Open Office Calc 

2. Which of the following applications was the parent to Open Office Calc? [S-2021] 

            (a) Visicalc    (b) LibreCalc   (c) Lotus 123   (d) Star Office Calc. 

3. Grid of cells with a programmable calculator: [S-2020] 

(a) Spreadsheet   (b) Database  (c) Word processor  (d) Linux 

4. A column heading in Calc is represented using [M-2022] 

            (a)Number    (b) Symbol  (c) Date    (d) Alphabet 

5. Which key is used to move the cell pointer in the forward direction within work sheet? [M-2020, J-2023, J-2024] 

               (a)Enter    (b) Tab            (c) Shift + Tab   (d) Delete 

6. A formula in calc may begin with-------- [M-2019, M-2023] 

             (a) = .    (b) +       (c) -      (d) All the above 

7. Which of the following symbol is used to make a cell address as an absolute reference? [S-2020] 

             (a) +    (b) %   (c) &    (d) $ 

8.  Match the followings : [M-2020] 

1) Applications   i)  .ods  (a)1-iii,2-iv,3-i,4-ii  

2) Open office document ii) .odp  (b)1-ii,2-iv,3-i,4-iii 

3) Open office calc  iii) .exe  (c)1-iv,2-ii,3-iii,4-i 

4) Open office Impress  iv) .odt  (d)1-iii,2-i,3-iv,4-i 

9. What will be the result from the following formula (Assume A1=25, B2=2) + A1^B2 [M-2024] 

             (a) 252   (b) 27   (c) 625    (d) 50 

(CHAPTER-8) (Office Automation Tools - Presentation Basics) 
1. Which is the shortcut key to view the slideshow in impress? [S-2021, M-2024] 

(a) F6     (b) F9     (c) F5     (d) Both (b) or (c) 

2. Identify the extension of the Impress presentation. [M-2023] 

(a) ,odp     (b).ppt    (c).odb    (d),ood 

(CHAPTER-9) (Introduction to Internet and Email) 

1. What is the expansion of WLAN? [M-2020] 

                 (a)Wireless Local Area Network      (b) Wired local Area Network     

 (c) Wireless Local Area Netware      (d) Wireless Area Netbande 
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2. Range of Campus Network is--- [S-2020] 

          (a) 10 KM    (b) 5 KM    (c) 25 KM    (d) 20 KM 

3. Each computer on net is called   [J-2019] 

  (a) Host     (b) server    (c) workstation   (d) node 

4. Expansion of W3C [M-2022, J-2024] 

               (a) World Wide Web Consortium    (b) Wide World Web Consortium  

               (c) World Web Wide Consortium    (d) World Wide Web Consortum 

5. W3C was established in 1994 by ---- [S-2022] 

               (a) Tim Berners-Lee      (b) Tim Burnard Lee  (c) Kim Berners                (d) Kim Bernard Lee 

6. Hotspot uses which type of network services? [J-2023, M-2024] 

              (a) LAN    (b) PAN   (c) WLAN   (d) CAN 

7. USB WiFi adapters are often called as [M-2023] 

              (a) Data Card   (b) Pen Drive   (c) Dongles   (d) Memory Card 

8. How many types of websites are available? [M-2019] 

           (a) 3       (b) 2      (c) 4      (d) 6  

(CHAPTER-10) (HTML - Structural Tags) 
1. HTML is acronym for [S-2021] 

             (a) Hyper Transfer Markup Language     (b) Hyper Text Markup Language  

             (c) Hyper Transfer Makeup Language     (d) Hyper Text Makeup Language 

2. HTML tags should be specified within: [M-2019] 

(a) [ ]       (b) { }      (c) ( )        (d) < > 

3. An HTML document is bounded within a pair of ….. tags [M-2020] 

           (a) <body> ……. </body>       (b) <title> ……. </title>  

             (c) <html> ……. </html>        (d) <head> …… </head> 

4. Which of the following symbol is used to define a closing tag? [M-2022] 

          (a) < >     (b) %        (c) /     (d) \ 

5. Which section of the browser window displays the main contents? [S-2020] 

           (a) Head    (b) Body   (c) Title    (d) Heading 

6. How many levels of heading tags available in HTML? [S-2022, J-2023, J-2024] 

            (a) 6     (b) 4    (c) 8    (d) 3 

7.  The tag used to insert a line break: [J-2019, S-2022] 

            (a) <h1>        (b) <br>           (c) <html>        (d) <p> 

8.  Which of the following tag is a structural tag? [M-2024] 

(a) <p>      (b) <h1>      (c) <br>     (d) <body> 

(CHAPTER-11)(HTML- Formatting text, Creating Tables, List and Links) 
1. Which of the following tags are called as physical style tags? [M-2020, J-2023] 

             (a) <html>, <b>, <br>           (b) <b>, <br>, <u>  (c) <A>, <b>, <i>               (d) <b>, <i>, <u> 

2. Which feature is used to call attention to the reader? [M-2019, J-2024] 

             (a) Highlight   (b) Bold   (c) Italics   (d) Underline 

3. The tags <sub> and <sup> used for: [S-2020, S-2022] 

             (a) Subject and Super            (b) Subscript and Super  (c) Subject & sub       (d) Subscript and Superscript 

4. Pick odd one from the list….  [S-2021]   

       (a) <tr>    (b) <th>    (c) <dh>   (d) <td> 

5. Definition list has how many parts? [J-2019]   

       (a) 5    (b) 4    (c) 3    (d) 2 

6. A list block can be defined inside another list is: [M-2022, M-2023] 

            (a) Inner List    (b) Nested List   (c) Outer List   (d) Listing List 

7.  To create internal link, which of the following attribute should be used? [M-2024] 

            (a) link    (b) name  (c) local    (d) Inter 

(CHAPTER-12) (HTML - Adding multimedia elements and Forms) 
1. Which image format was standardize by W3C?  [M-2020, M-2024] 

             (a) JPEG    (b) SVG   (c) GIF    (d) PNG 

2. The tag used to insert an image in HTML:  [M-2019, M-2022] 

(a) Image    (b) Picture   (c) Img    (d) Pic 
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3. In Inline sound can be inserted using which of the following tag? [J-2019, S-2021] 

           (a) <inline>    (b) <backgroundsound>  (c) <bgsound>  (d) <sound> 

4. The important attributes used with the <form> tag are [M-2020, S-2022, J-2023, J-2024] 

           (a) method and action  (b) name and size  (c) post and get   (d) type and name 

5. The tag is used to create dropdown list box in HTML is: [M-2023] 

            (a) <dropdown>   (b) <select>    (c) <listbox>     (d) <input> 

(CHAPTER-13)  (CSS - Cascading Style Sheets) 
1. Which of the following is the page level style? [S-2022] 

             (a) <Page>    (b) <Style>   (c) <Link>  (d) <H> 

2. CSS is also called as: [S-2020, M-2023] 

             (a) Sitewide Style Sheets     (b) Internal Style Sheets  

(c) Inline Style Sheets     (d) Internal Inline Sheets 

3. The extension of CSS file is------ [M-2019, J-2024] 

            (a) .ssc    (b) .css    (c) .csc    (d) .htm 

4. What is selector in CSS? [J-2019] 

           (a) Property    (b) Value   (c) HTML tag   (d) name 

5. The Declaration block of CSS is surrounded by [S-2021] 

           (a) ( )    (b) [ ]    (c) { }    (d) <> 

6. The declaration should be terminated by [M-2022] 

            (a) :     (b) ;    (c) .    (d) , 

7. Which of the following indicates that the text included is a comment? [S-2020, J-2023] 

             (a) /* */    (b) !* *!    (c) <* *>   (d) \* *\ 

(CHAPTER-14) (Introduction to JavaScript) 

1. Expand CGI ----- [S-2020] 

             (a) Common Gateway Interface    (b) Complex Gateway Information  

              (c) Common Gateway Information    (d) Complex Gateway Interface 

2. Java Scripts can be implemented using which statements? [J-2019, J-2024] 

          (a) <head>    (b) <Java>   (c) <script>  (d) <text> 

3. Expand DHTML ----- [M-2024] 

(a) Distance Hyper Text Markup language    (b) Dynamic Hyper Text Markup language  

             (c) Distance High Text Markup language   (d) Dynamic High Text Markup language 

4. The file reload into the browser use the shortcut key is [M-2019] 

 (a) F2    (b) F3    (c) F4    (d) F5 

5.  Which is mostly used to give a warning message to users? [M-2022] 

(a) Alert Dialog Box   (b) Confirm box    (c) Prompt box   (d) Display box 

6.   What is the output of the following snippet: x=”JavaScript”; x.length(); [J-2019]  

  (a) 8   (b) 9   (c) 10   (d) 15 

(CHAPTER-15) (Control Structure in JavaScript) 
1. Which conditional statement is used to transfer control from current statement to another statement? [M-2022, S-2020, J-2023] 

                (a) Branching   (b) Sequencing   (c) Looping   (d) Interacting 

2. _______statement can be used as alterative to if-else statement [M-2020, M-2024] 

            (a) While    (b) If    (c) else-if   (d) Switch 

3. Which of the following is not a looping statement? [S-2021, M-2023, J-2023] 

              (a) Switch    (b) While   (c) Do-While   (d) For 

4. What will be the output for the following snippet: [M-2019]  

for (var n=0; n<10; n+1) { if (n==3) { break; }document write (n+"<br>"); } 

                (a) 0 1 2    (b) 0 1 2 3     (c) 0 1 2 3 4     (d) 0, 1, 3 

5. In the blow snippet Value of X is ….Var  X=102+5-50 [J-2023[ 

(a) 57   (b) 47   (c) 50   (d) 52 

(CHAPTER-16) (JavaScript Functions) 
1. The parameters work as-------  [M-2024] 

(a) Local variable   (b) Global Variable   (c) File variable   (d) block variable 

2. Predefined functions are also called as----- [M-2019, S-2020, M-2022]   

(a) Library functions  (b) storage functions  (c) instructions    (d) commands 
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3. Larger programs are divided into smaller are called [M-2023] 

(a) modules    (b) block   (c) sets    (d) Group 

4. Which of the following allow the programmer to modularize a program [J-2024]       

           (a) Library    (b) user defined functions  (c) Normal     (d) Ordinary  

5. Library functions are also called as----- [J-2023] 

(a) Predefined functions  (b) storage functions  (c) instructions    (d) commands 

(CHAPTER-17) (Computer Ethics and Cyber Security) 
1. Commercial programs made available to the public illegally are known as [S-2021, J-2024] 

(a) Freeware    (b) warez   (c) Free software   (d) software 

2. Which one of the following are self-repeating and do not require a computer program to attach themselves?  

(a) Viruses     (b) worms   (c) spyware   (d) Trojans  [M-2019] 

3. Which one of the following tracks a user visits a website? [M-2020, J-2023] 

(a) Spyware   (b) cookies  (c) worms  (d) Trojans 

4. The process of converting cipher text to plain text is called [M-2024] 

(a) Encryption   (b) Decryption   (c) key    (d) proxy server 

5. Distributing unwanted e-mail to others is called. [S-2020] 

(a)  Scam    (b) spam   (c) fraud   (d) spoofing 

(CHAPTER-18) (TAMIL COMPUTING) 
1. Which is not a search engine? [J-2019]  

        (a) Android   (b) Bing   (c) Yahoo  (d) Google 

2. Which of the following is the first Tamil Programming language? [S-2020, M-2022] 

(a)  Kamban   (b) Azhagi  (c) Tamil Open Office (d) Ezhil 

3. ---is a Tamil translation application [S-2021] 

(a) Lippikar   (b) Tamizpori  (c) Kamban  (d) Ezhil 
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        CHAPTER 1 TO 18 TWO MARK public QUESTION with ANSWERS [MARCH-2019 TO JULY-2024] 
 CHAPTER – 1 Introduction to Computers 
1. What is a computer? [M-2019]                                                                       

❖ It is an electronic device that processes the input according to the set of instructions provided to it and gives 

the desired output at a very fast rate. 

2. Distinguish between data and information. [M-2023] 

Data Information 

❖ Data is defined as an unprocessed collection of raw 

facts, suitable for communication, interpretation or 

processing.  

❖ Information is a collection of facts from 

which conclusions may be drawn. 

❖ It do not convey any meanings ❖ It conveys some meaning 

❖ Eg: 134,16, ‘kavitha’  ❖ Kavitha is 16 years old. 
 

3. What are the components of a CPU? [S-2022, J-2023, J-2024] 

❖ The CPU has three components which are , 

❖ Control unit, Arithmetic and logic unit (ALU) and Memory unit. 

4. What is the function of an ALU?  [J-2019, M-2022] 

❖ The ALU is a part of the CPU where various computing functions are performed on data.  
❖ The ALU performs arithmetic operations such as addition, subtraction, multiplication, division and logical operations.  

5. Write the functions of control unit. [M-2024] 

❖ The control unit controls the flow of data between the CPU, memory and I/O devices.  

❖ It also controls the entire operation of a computer. 

 CHAPTER – 2 Number Systems 
1. Convert  (46)10  into equivalent binary number  [M-2024] 

 2 46      LSB 

2  23-0           (46)10  = (101110)2 

2  11-1 

2  5-1  

2  2-1 

    1-0     MSB 

2. 11.0112 Binary to decimal equivalent  [M-2020] 

(11)2 = 3          21  20    . 2-1    2-2   2-3                                                    =3+ .( 0x0.5+1x0.25+1x0.125 ) 

                                                                                                    (0       + 0.25   +0.125) 

                       1    1     .  0     1     1                                   

                                                                           (11.011)2 = (3.375)10 

3. Convert (65)10 into Binary number  [S-2021, M-2022] 

2  65      LSB 

2  32-1           (46)10  = (1000001)2 

2  16-0 

2  8-0 

2  4-0 

    2-0     

    1-0     MSB 

4. What is meant by signed magnitude? [M-2023] 

❖ The simplest method to represent negative binary numbers is called Signed Magnitude. 

5. Convert  (1560)8  into equivalent Decimal number  [J-2023] 

Weight 512 64 8 1 

Positional 

Notation 

83 82 81 80 

Given  

number 

1 5 6 0 

(1560)8 = 512x1+64x5+8x6+1x5 

             = 512+320+48+0 

(1560)8 = (880)10 

6. Convert (150)10 into Binary number [J-2024]                                                                                

2  150        (150)10 = (10010110)2 

2  75-0                                                    

2  37-1                                                                   

2  18-1                                                            

2  9-0                                                              

2  4-1 

2  2-0          

    1-0                          
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 CHAPTER – 3 Computer Organization 
1. What is an instruction? [M-2019] 

❖ A command which is given to a computer to perform an operation on data is called an instruction. 

2. What is a program counter?  [M-2019, S-2020, M-2023] 

❖ The Program Counter (PC) is a special register in the CPU which always keeps the address of the next 

instruction to be executed. 

3. What is HDMI? [S-2020] 

❖ High-Definition Multimedia Interface is an audio/video interface transfers the uncompressed video and audio 

data from a video controller, to a compatible computer monitor, LCD projector, digital television etc. 

4. Which source is used to erase the content of an EPROM? [S-2021, J-2024] 

❖ Ultra violet light is used to erase the content of a EPROM. 

❖ EPROM retains its contents until it is exposed to ultraviolet light.  

❖ The ultraviolet light clears its contents, making it possible to reprogram the memory. 

5. What is an instruction set? [AUG-2022] 

Basic set of machine level instructions that a microprocessor is designed to execute is called as an instruction set. 

6. What is Bus? [J-2019] 

❖ A bus is a collection of wires used for communication between the internal components of a computer. 

 CHAPTER – 4 Theoretical Concepts of Operating System 
1. What is the multi-user Operating system?  [M-2019, M-2023] 

❖ It is used in computers and laptops that allow same data and applications to be accessed by multiple users at 

the same time.  

❖ The users can also communicate with each other. Example : Windows, Linux and UNIX  

2. What is a GUI? [J-2019, S-2021, M-2023] 

❖ The GUI is a window based system with a pointing device to direct I/O, choose from menus, selections and a 

keyboard to enter text. 

❖ Its vibrant colours attract the user very easily. 

3. What are the security management features available in Operating System? [S-2022, J-2024] 

❖ The Operating System provides three levels of securities to the user end.  

❖ They are, 1.File access level, , 3.Network level  

1. File access level: Permissions can either be granted by the creator of the file or by the administrator of the system.  

2. System level: System level security is offered by the password in a multi-user environment. 

3. Network level: Network security is an indefinable one. So people from all over the world try to provide such a security. 

4. What are the different Operating Systems used in computer? [M-2024] 

❖ Operating system used personal computers and laptops are Windows, UNIX and Linux. 

5. Name some popular operating system used in personal computer and mobile devices. [M-2022] 

1.Personal computer O.S – Windows, Linux, Unix  2.Mobile O.S – Android, Ios 

6. What are the security management levels available in Operating System? [S-2020] 

1. File access level  2.System level 3.Network level 

7. Define software and mention its types [AUG-2022] 

❖ A software is set of instructions that perform specific task.  

❖ It interacts basically with the hardware to generate the desired output. 

❖ Software is classified into two types: 1) Application Software 2) System Software 

 CHAPTER – 5 Working with Windows Operating System 
1. What is known as Multitasking?   (J-2023)                                                          

❖ Multiple applications can execute simultaneously in Windows, and this is known as “Multitasking”. 

2. What are called standard icons (M-2022) 

❖ The icons which are available on desktop by default while installing Windows OS are called standard icons.  

❖ The standard icons available in all Windows OS are My Computer, Documents and Recycle Bin. 

3. Differentiate Files and Folders. (AUG-2022) 

                   Files              Folders 

❖ All types of information are stored in the 

form of files in the computer 

❖ Folders are containers of files that is used to organize 

files. 

❖ A file consists of a collection of data. ❖ A folders stores and folders. It also called a directory. 

❖ Each file has its own extension ❖ A folder does not have any extension. 
❖ Folder and sub folders cannot be created in a file.  ❖ Folder and sub folders cannot be created in a file. 

 

4. How will you Rename a File? (S-2022)(M-2023) 

1. Select the File or Folder you wish to Rename. 2. Click File→ Rename. 

3. Type in the new name.  4. To finalise the renaming operation, press Enter as in Folder. 

Rename, Using the  File  menu, Using Right mouse button, Using left mouse button. 

5. What is open source? (M-2019) 

❖ Open source refers to a program or software in which the source code is available in the web to the general 

public free of cost. 
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 CHAPTER – 6 Introduction to Word Processor 

1. How do you insert pictures in to your document?  (S-2021)                                

❖ Place the insertion pointer where you want the image to appear 

❖ Select Insert → Picture → From file 
❖ The insert picture dialog box appears where the picture gallery opens from which the desired picture can be selected. 

❖ If the picture is not in the gallery, then browse the pictures from the folder, choose the desired picture. 

❖ Click on the Open button 

❖ The selected picture is inserted into the document. 

2. What are the different packages in Open Office writer? (S-2020) 

1.OpenOffice Writer    - Word Processor to create text documents  

2. OpenOffice Calc       - Spreadsheet to create worksheets  3.OpenOffice Base       - Database  

4. Open Office Impress - Presentation software                    5.OpenOffice Draw      - Drawing Software  

6. OpenOffice Formula - Create formula and equations. 

3. What is auto text in writer?  (S-2021)  

❖ AutoText allows you to assign text, tables, graphics and other items to a key or key combination.  
❖ For example, rather than typing “TamilNadu” every time you use that phrase, you might just type “tn” and press F3. 

❖ You can also save a formatted Tip as AutoText and then insert a copy by typing "tip" and pressing F3. 

4. How will you merge cells in a table? (J-2023) 

To merge a group of cells: 

1. Select the cells to merge. 

2. Right click and choose Cell → Merge or choose Table → Merge Cells from the menu bar. 

5. State the differences between proprietary software and open source software.  [M-2024] 

Proprietary software Open source software 

❖ Users must have to pay to get the proprietary software ❖ Users can get open source software free of cost. 
❖ Ex: Ms-office, Photoshop ❖ Ex: Libre office, python 

 

Proprietary software Open source software 

Package Developer Package Developer 

Microsoft Word Microsoft Corporation OpenOffice Writer Apache 

WPS Word King soft LibreOffice Writer The document foundation 

WordPro Lotus Corporation Abiword Abi source 
 

6. Write about short cut keys for LEFT,RIGHT, CENTER AND JUSTIFIED alignments. (M-2019) 

1.LEFT       -  Ctrl +L    2.RIGHT        –   Ctrl +R  3.CENTER -   Ctrl +E   4.JUSTIFIED -    Ctrl +J 

7. What is word wrap? (M-2020) 

❖ When the text reaches the end of the line, the word is automatically wrapped to the next line. 

❖ This is feature is my word processor is known as word wrap. 

8. What are the different types of data? (M-2020) 

1. Alphabetic data type 2.Numeric data type 3. Alphanumeric data type 4. Date data type 5.Time data type. 

 CHAPTER -7 Working with Open Office Calc 

1. What are the types of toolbars available in Open Office calc?    (S-2022)          

❖ There are three toolbars available by default.  

❖ They are: (1) Standard Toolbar (2) Formatting Toolbar (3) Formula bar 

2. What is a Cell pointer?  (M-2019)(S-2021)(M-2023) 

❖ Cell pointer is a rectangle box which can be moved around the worksheet.  

❖ The call in which the cell pointer is currently located is known as “Active cell” 

3. Write about the text operator in Open Office Calc. (J-2023, J-2024) 

❖ In Calc, “&” is a text operator which is used to combine two or more text. Joining two different texts is also 

known as “Text Concatenation”  

❖ Syntax: text reference 1 & text reference 2   Example:       =A1 & B1 

4. What are the different types of data? (M-2020) 

1.Alphabetic 2.Numeric 3.Alphanumeric 4. Date data type 5. Time data time 

5. What are the Backspace key and delete key functions in open office writer? (J-2019) 

Deleting data using Backspace Deleting data using Delete key. 

Backspace key is used to delete the character left of 

the insertion pointer of the cell. 

Delete key is used to delete the character right of the 

insertion pointer of the cell. 
 

6. Write the formula to find the sum of the contents of the cells A1,A2 and A3 in a worksheet (J-2019) 

Ans:       =A1+A2+A3 (Add the values in cells A1,A2 and A3) 

 CHAPTER- 8 Presentation Basics 

1. What do you understand by a presentation? (M-2022) 

❖ A presentation software is a computer software package used to show information, in the form of a slide show. 

❖ Each slide uses a variety of multimedia elements that grabs the viewer’s attention and retains it. 
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2. Define a template in Impress. [M-2024] 

❖ Design already created as the basis for a new presentation 
❖ Premade design used to create a new presentation. 

3. Define Slide transition (M-2020) 

❖ A slide transition is the visual effect that occurs when you move from one slide to the next during presentation. 

❖ Transitions are available, including No Transition.  

❖ You can select the transition speed (slow, medium, fast)  

❖ You can also choose between an automatic or manual transition. 

4. What is presentation software? (S-2020) 

❖ A presentation software is a computer software package used to show information, in the form of a slide show. 

5. What is use of slide sorter view in impress? (J-2019) 

❖ The Slide Sorter view contains all of the slide thumbnails.  

❖ Use this view to work with a group of slides or with only one slide. 

Change the number of slides per row, if desired: 

❖ Check View → Toolbars → Slide View to show the Slide view toolbar. 

❖ Adjust the number of slides (up to a maximum of 15). 
❖ After you have adjusted the number of slides per row, View → Toolbars → Slide View will remove this toolbar from view 

 CHAPTER- 9 Introduction to Internet and Email 

1. What is a network? (M-2023) 

❖ A network is a collection of interconnected devices (such as computers, printers, etc.). 

❖ Several networks are connected together to from a global network is called the internet. 

2. What is CC and BCC in an email? (M-2022)  

❖ The CC (Carbon Copy) field allows you to specify recipients who are not direct addressees  

❖ The BCC (Blind Carbon Copy) field is similar to CC, except the recipients are secret. 

❖ Each BCC recipient will receive the e-mail, but will not see who else received a copy. 

 CHAPTER- 10 HTML - Structural Tags 

1. Explain with the help of an example the difference between container and empty elements of HTML. (M-2019) (M-2020) 

Container Elements Empty  Elements 

❖ The tags which are required opening and closing 

is known as container elements or tags.  

❖ Ex : <html>, <body>, <title>, <p>  

❖ The tags which are required only opening tag is 

known as empty elements or tags.  

❖ Ex:   <br>, <hr> 
 

2. How do you define comments in HTML? (J-2019)(S-2020) (J-2023) 

❖ Comments are used to describe the page or provide some kind of indication of the status of the page.  

❖ The tag <!> is used to create comments.  

Syntax:      <! comments > 

Example:  < !This is my first my web side about my college> 

❖ In HTML, the text what you type within this tag is considered as comments and it is ignored by the browser 

3. Write an attribute of heading tag with example (M-2020) 

❖ Headings are used to include titles to sections of a web page.  

❖ HTML has six levels of headings viz. <h1> to <h6>. 

Syntax:    <h…> Heading text </h…> 

Example: 

<html>  

<head>  

<title> Heading </title> 

</head> 

<body>  

<h1> Welcome to Computer Application</h1>  (to) 

<h6> Welcome to Computer Application</h6> 

</body> 

</html> 

4. Write the output of the following HTML code.  (J-2019) 

<HTML>                               OUTPUT 

<BODY>                                 LAN 

<UL>                                       MAN 

   <LI> LAN                            WAN 

   <LI> MAN 

   <LI> WAN 

   </UL> 

</BODY> 

</HTML> 
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5. Write the output of the following HTML code.  (M-2019) 

<HTML>                               OUTPUT 

<BODY>                                 KEY BOARD 

<OL>                                       MONITOR 

   <LI> KEY BOARD              SPEAKER 

   <LI> MONITOR 

   <LI> SPEAKER 

   </OL> 

</BODY> 

</HTML> 

6. Write the output of the following HTML code.  (J-2024) 

<html>                                                                                    OUTPUT 

<head>                                                                                    Tamil 

<title> Number List </title>                                                   Telugu 

</head>                                                                                   English 

<body>                                                                                    Computer Applications                           

<OL>                                                                                       Commerce                     

   <LI> Tamil                                                                           Accountancy                                                

   <LI> Telugu                                                                          Economics 

   <LI> English                                                                          

   <LI> Computer Applications 

   <LI> Commerce 

   <LI> Accountancy 

   <LI> Economics 

</OL> 

</body> 

</html> 

 CHAPTER- 11 HTML - Formatting text, Creating Tables, List and Links 

1. Write a short note on    (i) <strong>    (ii) <em> (J-2019)(J-2023)(M-2020)(M-2023)                 
<strong> Important text : 

1. The <strong> tag is a phrase tag. 2. It is used to define important text by displaying text as bold. 

Ex: <strong> Computer Applications </strong>      Output: Computer Applications 

<em> - Emphasized text: 

1. The <em> tag is used to emphasize the text.  2. That means, when you use this tag, the text will be in italics. 

Ex: <em> Computer Applications </em>      Output: Computer Applications 

2. What is thematic break?  (M-2022) 

❖ The <hr> (Horizontal Rules) tag, which is known as “Thematic Breaks” separate sections of an 

HTML document visually. 

❖ It produces a horizontal line spread across the width of the browser. 

❖ This is an empty tag. 

3. What are the types of list in HTML? (M-2019)(S-2022)(M-2024) 

❖ HTML supports three types of lists. 

     1. Numbered List / Ordered List, 2.Un-numbered List / Unordered List 3.Definition List. 

4. Write an attribute of heading tag with example. (M-2020) 

❖ Align is an attributes to set right, center and justify alignment to headings. 

❖ Left if the default alignment, so that it is not supported in latest version of HTML. 

❖ Justify alignment is not supported by older browsers. 

Syntax:       <h# align = value>    Example:   <html> 
5. Write a short note on a) <big> b) <small> (S-2020) 

<big>   

❖ The <big> tag is used to define the text bigger in size than the normal size.  

❖ It is often used to call attention to a text.  

<small>  

❖ The <small> tag is used to define the text smaller than the current size.  

❖ These two tags are container tags. 

 CHAPTER- 12 HTML - Adding multimedia elements and Forms 

1. List out the popular image formats: (M-2019) (M-2022)                                      
1. GIF (Graphical Interchange Format) 2. JPEG (Joint Photographic Experts Group) 

3. PNG (Portable Network Graphics)    4.SVG (Scalable Vector Graphics) 
2. Write down the general format of marquee (S-2022) (M-2023) 

❖ <marquee> Text or image to be scroll </marquee> 
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3. What is inline sound or movie? (S-2020) 

❖ Music can be played in the background to a webpage, while the page is viewed.  

❖ This is known as ‘inline’ sound or movie. 

❖ The <bgsound> tag is used to attach an inline sound file in HTML. 

4. What is the purpose of <input> tag? (S-2021, J-2024) 

❖ Most of the form controls are created by using <input> tag. 
❖ The <input> is an empty tag used to create different form elements or controls such as text box, radio buttons so on. 

 CHAPTER- 13 CSS - Cascading Style Sheets 

1. What is the use of <style> tag?   (J-2023)                                                            

❖ A style tag is used to change the default characteristics of a particular tag in the entire web document 

wherever that tag is used. 

Ex:    <style>  

               h3  

               { color:blue;  font-family: "Copper plate Gothic Bold";  

               font-size:14pt; }  

               </style> 
2. What is CSS?  (J-2019)S-2020) 

❖ Cascading Style Sheets (CSS) are also called as Site wide Style sheets or external style.  

❖ CSS is a style sheet language used for describing the formatting of a document written in HTML. 

3. Write the general format of linking CSS with HTML. (M-2022) 

❖ <Link rel = “style sheet” type = “text/css” href = CSS_File_Name_with_Extension> 

4. Write down general format of CSS declaration. (CSS Rules) (S-2021) 

Selector                         Declaration  

HTML Tag                { Properties : Values; } 

Example: 

Selector                               Declaration of properties and values 

P                                         {  

                                                Font-size : 16pt;  

                                                color : red;  

                                                font-weight : bold; 

                                             } 
 CHAPTER- 14 Introduction to Java script 

1. Write a syntax of <script> tag (S-2020) 

<script language="javascript" type="text/javascript">  

  JavaScript code 

</script> 
2. What is scope of variables and types of scope variable? (S-2022) 

❖ The scope of a variable is the life time of a variable of source code in which it is defined.  

1.Global: A global variable has global scope; it can be defined everywhere in the JavaScript code. 

2.Local: Variables declared within a function are defined only within the body of the function. 

❖ They are local variables and have local scope. 
 CHAPTER- 16 JavaScript Functions 

1. What is a function in JavaScript?   (J-2023)                                                         
❖ A function is a block of JavaScript code that is defined once but may be executed or invoked any number of times. 

2. Write a note on Library functions. (M-2019)(S-2021)(M-2020) 

❖ Pre-defined functions are already defined in the JavaScript library which are also called Library functions.  

❖ Example: toUpperCase(), toLowerCase() , alert( ),write() etc. 

3. Write any four common library functions (M-2020) 

1.isNaN( ), 2.toUpperCase( ), 3.toLowerCase( ), 4.length( ), 5.alert( ), 6.prompt( ),    7.write( ) 

 CHAPTER – 17 Computer Ethics and Cyber Security 
1. What is harvesting? (M-2019)                                                                      

❖ A person or program collects login and password information from a legitimate user to illegally gain access to 

others’ account(s) is called harvesting. 

2. What is a Cookie? (J-2019, J-2024) 

❖ A cookie is a small piece of data sent from a website and stored on the user's computer memory (Hard drive) 

by the user's web browser while the user is browsing internet. 

3. What is Phishing? (S-2022, M-2024) 

❖ Phishing is a type of computer crime used to attack, steal user data, including login name, password and credit 

card numbers etc. through emails. 

❖ Phishing scams are fraudulent attempts by cyber criminals to obtain private information. 
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4. What are the guidelines to be followed by any computer user? (S-2022) 

1.Honesty:  

❖ Users should be truthful while using the internet. 

2.Confidentiality:  

❖ Users should not share any important information with unauthorized people. 

3.Respect:  

❖ Each user should respect the privacy of other users.  

4.Professionalism:  

❖ Each user should maintain professional conduct. 

5.Obey The Law:  

❖ Users should strictly obey the cyber law in computer usage. 

6.Responsibility: 

❖ Each user should take ownership and responsibility for their actions. 

5. What are the two types of encryption? (S-2020) 

❖ Encryption is the process of translating the plain text data (plaintext) into random and mangled data (called cipher-text). 

❖ For example data being transferred via networks (e.g. the Internet, ecommerce), mobile telephones, wireless 

microphones, wireless intercom systems, Bluetooth devices and bank automatic teller machines.. 

6. What is cyber-crime? (M-2024) 

❖ A cyber-crime is a crime which involves computer and network. 

❖ Cyber-crime is an intellectual, white-collar crime. 

❖ Those who commit such crimes generally manipulate the computer system in an intelligent manner. 

 CHAPTER – 18 Tamil Computing 
1. List of the search engines supporting Tamil.  (M-2020)(M-2022)(J-2023)(M-2024)   

❖ Google and Bing 

2. Write a short note about Tamil Programming Language. (J-2024) 

❖ Programming languages to develop software in computers and smart phones are available only in English.  

❖ Based on Python programming language, the first Tamil programming language “Ezhil” (எழில்) is designed. 

3. What TSCII? (M-2020) 

❖ TSCII (Tamil Script Code for Information Interchange) is the first coding system to handle our Tamil language. 

❖ This encoding scheme was registered in IANA (Internet Assigned Numbers Authority) unit of ICANN. 

4. Write a note on Unicode. (S-2020) 

❖ Unicode is an encoding system, designed to handle various world languages, including Tamil.  

❖ Its first version 1.0.0 was introduced in October 1991.  

❖ Unicode is the best suitable to handle Tamil. 

5. What are the familiar keyboard used for Tamil typing? (J-2019) 

❖ NHM Writer, E-Kalappai and Lippikar – are familiar Tamil keyboard interfaces software that is used for Tamil 

typing which works on Tamil Unicode, using phonetics.  

❖ Sellinam and Ponmadal – are familiar Tamil keyboard layouts that works on Android operating system in 

Smart phone using phonetics.  
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         CHAPTER 1 TO 18 THREE MARK public QUESTION with ANSWERS [MARCH-2019 TO JULY-2024] 

 CHAPTER – 1 Introduction to Computers 
1. What are the characteristics of a computer? (M-2023)                                       

1.Speed: Computers can work very fast.                                   2.Accuracy: The degree of accuracy of computer is very high. 

3.Consistency: Computer is consistent in their performance.   4.Memory: Computer has the ability to store and retrieve data. 

5.Storage Capacity: Computers have high storage capacity.    6.Automation: Computer can perform tasks automatically.  

2. What is an input device? Give two examples. (M-2023) 

❖ An input device is a hardware or peripheral device used to send data to a computer  
❖ Input device is used to feed any form of data to the computer, which can be stored in the memory unit for further processing. 

Example: 

1.Keyboard, 2.mouse, 3.Scanner, 4.Fingerprint scanner, 5.Track Ball, 6.Retinal Scanner, 7.Light pen etc. 

3. Name any three output devices. (S-2021, J-2024) 

1. Monitor: Monitor is the most commonly used output device to display the information. 

2. Printer: Printers are used to print the information on papers 

3. Plotter: Plotter is an output device that is used to produce graphical output on papers. 

4. Speaker: Using speaker along with speech synthesise software, the computer can provide voice output. 

5. Multimedia Projectors: Multimedia projectors are used to produce computer output on a big screen 

4. Write the characteristics of sixth generation. (M-2022) 

❖ Sixth Generation, computers could be defined as the era of intelligent computers, based on Artificial Neural Networks. 

❖ One of the most dramatic changes in the sixth generation will be the explosive growth of Wide Area Networking. 

❖ Natural Language Processing (NLP) is a component of Artificial Intelligence. 

❖ It provides the ability to develop the computer program to understand human language. 

 CHAPTER – 2 Number Systems 
1. What is radix of a number system? Give example. (M-2022)                          

❖ Each number system is uniquely identified by its base value or radix.  

❖ Radix or base is the count of number of digits in each number system. 

❖ Radix or base is the general idea behind positional numbering system. 

Example:  

1.Binary –Radix 2 (1010)2      2.Octal – Radix 8 (457)8    

3.Decimal- Radix 10 (314)10   4.hexa-Decimal – Radix 16 (25F)16 

2. Write note on binary number system. (S-2022) 

❖ There are only TWO DIGITS in the Binary system, namely, 0 and 1. 
❖ The numbers in the binary system are represented to the base 2 and the positional multipliers are the powers of 2. 

❖ The left most bit in the binary number is called as the Most Significant Bit (MSB) and it has the largest 

positional weight. 

❖ The right most bit is the Least Significant Bit (LSB) and has the smallest positional weight. 

1 1 0 1 

                     MSB                            LSB 

3. Convert (150)10 into Binary, then convert that Binary number to Octal (S-2020) 

Step :1  (Decimal to Binary)                                                                                   

2  150        (150)10 = (10010110)2 

2  75-0                                                     Step :2   (Binary to Octal) 

2  37-1                                                                   (10010110)2   (?)8            

2  18-1                                                             010  010  110           (150)10 = (226)8 

2  9-0                                                                 2      2      6        

2  4-1 

2  2-0          

    1-0                          

4. Convert 34010 to its equivalent Binary, Octal and Hexadecimal (J-2019) 

Step :1    Decimal to binary 

2  340        (340)10 = (101010100)2 

2  170-0        Step :2   (Binary to Octal) 

2  85-0                 (101010100)2   (?)8            

2  42-1                 101  010  100             (340)10 = (524)8 

2  21-0                  5      2      4        

2  10-1 

2  5-0           Step : 3  (Binary to Hexadecimal) 

    2-1                    (101010100)2   (?)16 

    1-0                      0001   0101 0100                 (340)10 = (154)16 

                                   1        5      4      

5. A) State whether the following numbers are valid or not. If invalid write reason. (S-2020) 

 1) (796)8  - Not valid (octal base value 0 to 7) 

2) (7GE)16  - Valid ( Hexadecimal base value 0 to 9 & A to F) 

3)(1110)2  - Valid ( Binary base value 0,1) 
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B) Write the number system for the following numbers.  

1) (926)10   - Decimal number system 

2) (ABC)16    - Hexadecimal number system 

3) (450)8 – Octal number system 

6. A) Add : 11012+10102   B) Subtract : 101002-11112      (M-2019) 

A) Add : 11012+10102  

1     

 1 1 0 1 

 1 0 1 0 

1 0 1 1 1 

 Ans: 11012+10102 = 101112 

B) Subtract : 101002-11112 

0 1 10 1 10 

1 0 1   0 0 0 

 1 1 1 1 

0 0 1 0 1 

Ans: 101002-11112 = 1012 

7. What is the decimal equivalent sequence for (547)8 octal sequence? (M-2020) 

(547)8  = 5x82+4x81+7x80 

             =5x64+4x8+7x1 

             =320+32+7 

             =(359)10 

8. a) Convert the octal number (67)8 into decimal number   (J-2019) 

Weight 8 1 

Positional 

Notation 

81 80 

Given  

number 

6 7 

(67)8 = 8x6+1x7 

             = 48+7 

(67)8 = (55)10 

b) Convert the decimal number (57)10  into hexadecimal number 

16 57 

      3 – 8            (57)10 = (38)16 

9. Add: (A)  -2010 + 2510  (M-2024) 

Step:1                                          Step:2                                           Step:3 

2 20       -20   = 10100                  2 25       25    = 11001                     -20  = 11101100 

2 10-0   8bit = 00010100            2 12-1      8bit  = 00011001               25 = 00011001 

2 5-0     1s = 11101011               2 6-0 

2 2-1                           1                2 3-0                                                  -5 =1000001012   

   1-0      2s= 11101100                    1-1                                                       [-2010 + 2510 = -510=1000001012 ] 

10 (B) 2210 + 1510       (M-2024) 

Step:1                                          Step:2                                           Step:3 

2 22       22  = 10110                     2 15         15      = 1111                  22 = 00010110 

2 11-0    8bit = 00010110             2 7-1         8bit   = 00001111          15 = 00001111 

2 5-1                                              2  3-1                      

   2-1                                              1-1                                                   37 = 001001012        

   1-0                                                                                                      [2210 + 1510 = 3710=001001012 ] 

11 A) Add : 10112+10012   B) Subtract : 10010102-101002      (J-2024) 

A) Add : 10112+10012    

1 1 1  

     1 0 1 1 

     1 0 0 1 

 1  0 1 0 0 

 10112+10012  = 101002 

B) Subtract : 10010102-101002       

  1 10  10   

 10 0 0 1  0 0 1 0 

   1 0 1 0 0 

  1 1 0 1 1 0 

10010102-101002     = 1101102 

 

www.Padasalai.Net                                                  www.TrbTnpsc.com

Kindly Send Me Your Study Materials To Us Email ID:   padasalai.net@gmail.com

PadasalaiPadasalai

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m
https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m


15 

                                         PREPARED BY...,    B.MOHAMED YOUSUF M.C.A., B.Ed..,    (PG ASST IN COMPUTER SCIENCE) 

                                    [yousufaslan5855@gmail.com] 

 CHAPTER – 3  Computer Organization 
1. Classify the microprocessor based on the size of the data. (M-2023) 

❖ Depending on the data width, microprocessors can process instructions. 

❖ 8-bit microprocessor 16-bit microprocessor 32-bit microprocessor and 64- bit. 

2. Write down the classifications of microprocessors based on the instruction set. (M-2022)(M-2024) 

❖ The size of the instruction set is important consideration while categorizing microprocessors. 

❖ There are two types of microprocessors based on their instruction sets. 

Reduced Instruction Set Computers (RISC) : 

❖ Example: Pentium IV, Intel P6, AMD K6 and K7.  

Complex Instruction Set Computers (CISC) : 

❖ Example: Intel 386 & 486, Pentium, Pentium II and III, and Motorola 68000. 

3. Differentiate PROM and EPROM. (S-2022) 

PROM EPROM 

❖ Data can be written only once and cannot 

be erased. 

❖ The ultra violet light clears its contents, making is 

possible to reprogram the memory. 

❖ Programmable read only memory is also a 

non-volatile memory. 

❖ Erasable Programmable Read Only Memory is a special 

type of memory. 

❖ PROMs retain their contents even when 

the computer is turned off. 

❖ EPROM retains its contents until it is exposed to 

ultraviolet light. 
 

4. Write down the interfaces and ports available in a computer.  (J-2023) 

❖ Serial Port: To connect the external devices, found in old computers.  

❖ Parallel Port: To connect the printers, found in old computers.  

❖ USB Ports: To connect external devices like cameras, scanners, mobile phones, external hard disks and printers to the computer.  

❖ VGA Connector: To connect a monitor or any display device like LCD projector.  

❖ Audio Plugs: To connect sound speakers, microphone and headphones.  

❖ PS/2 Port: To connect mouse and keyboard to PC.  

❖ SCSI Port: To connect the hard disk drives and network connectors. 

5. Differentiate CD and DVD.  (J-2019) (M-2020, J-2024) 

                CD                 DVD 

❖ CD stands for Compact Disk ❖ DVD Stands for Digital Versatile Disc. 

❖ CD data is represented as tiny indentations 

known as “pits” 

❖ DVD-ROM can be visually determined by 

nothing the number of data sides of the disc. 

❖ Capacity: CD-ROM is 700MB ❖ Capacity: 4.7 GB 

❖ Single-layered sides are usually silver-coloured. ❖ Double-layered sides are usually gold-coloured. 
 

6. Explain the types of RAM (AUG-2022) 

❖ There are two basic types of RAM   1.Dynamic RAM (DRAM) 2.Static RAM (SRAM) 

❖ Dynamic RAM being a common type needs to be refreshed frequently.  

❖ Static RAM needs to be refreshed less often, which makes it faster. 

 CHAPTER – 4 Theoretical Concepts of Operating System 
1. What are the advantages and disadvantages of Time-sharing features? (M-2023)   

Advantage : 

❖ For each task a fixed time is allocated. 

❖ The processor switches rapidly between various processes after a time is elapsed or the process is completed. 

❖ Avoids duplication of software 

❖ Many applications can run at the same time. 

Disadvantage : 

1. Unreliability during data transmission. 2. Problem of Reliability. 3.It consumes more resource 

2. List out the key features of Operating system (M-2022) 

1.User Interface (UI)          2.Memory  Management    3.Process management  

4. Security Management    5. Fault Tolerance               6.File Management 

3. Write a note on Multi processing. (J-2023) 

❖ This is a one of the features of Operating System.  

❖ It has two or more processors for a single running process (job).  

❖ Processing takes place in parallel is known as parallel processing. 
❖ The execution takes place in parallel, this feature is used for high speed execution which increases the power of computing.  

4. Write a note following process management system (a) FIFO  (b) SJF (S-2020) 

FIFO (First In First Out)Scheduling:  

❖ This algorithm is based on queuing technique.  

❖ Assume that a student is standing in a queue (Row) to get grade sheet from his/her teacher.  

❖ The other student who stands first in the queue gets his/her grade sheet first and leaves from the queue (Row).  

❖ Followed by the next student in the queue gets it corrected and so on.  

❖ This is the basic logic of the FIFO algorithm. 
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SJF (Shortest Job First)Scheduling:  

❖ This algorithm works based on the size of the job being executed by the CPU.  

❖ Consider two jobs A and B. 

❖ 1) A = 6 kilo bytes 2) B = 9 kilo bytes  

❖ First the job “A” will be assigned and then job “B” gets its turn. 

5. What is GUI? (M-2023) 

❖ User interface is one of the significant features in Operating System.  

❖ The only way that user can make interaction with a computer.  

❖ This is a main reason for key success of GUI (Graphical User Interface) based Operating System.  

❖ The GUI is a Window based system with a pointing device to direct I/O, choose from menus, and make 

selections and a keyboard to enter text.  

❖ Its vibrant colour attracts the user very easily. 

6. Write about security management (J-2019) 

Security Management:  

❖ The major challenge in computer and software industry is to protect user’s legitimate data from hackers.  

❖ The Operating System provides three levels of securities to the user end.  

❖ They are (1) File access level, (2) System level, (3) Network level  

❖ In order to access the files created by other people, you should have the access permission. Permissions can 

either be granted by the creator of the file or by the administrator of the system.  

❖ System level security is offered by the password in a multi-user environment.  

❖ Both windows and Linux offer the password facility.  

❖ Network security is an indefinable one. So people from all over the world try to provide such a security.  

❖ All the above levels of security features are provided only by the Operating System. 

7. Explain and list out examples of mobile OS (M-2019) 

1.Android: 

❖ A popular Operating System for mobile phone technology which is not linked with Apple products 

2.Apple Ios: 

❖ It is a mobile operating system. 

❖ Created and developed by Apple Inc. 

8. Write any 6 of the most popular Linux server distributors (M-2020) 

1.Linux Mint 2.Arch Linux 3.Deepin 4.Fedora 5.Debian 6.CentOS 

 CHAPTER – 5 Working with Windows Operating System 
1. What are the functions of Windows Operating System?   (M-2022)               

1. Access applications on the computer (word processing, games, spread sheets, calculators and so on). 
2. Load any new program on the computer. 3. File management activities, 4.Change computer settings. 

5. Manage hardware such as printers, scanners, mouse, digital cameras etc.,  
2. Write a note on Recycle bin. (M-2020)(S-2022) 

❖ Recycle bin is a special folder to keep the files or folders deleted by the user, which means you still have an 

opportunity to recover them.  

❖ The user cannot access the files or folders available in the Recycle bin without restoring it 

❖ Restore option is used to restore file or folder from the Recycle bin. 

3. Write a note on the elements of a window. (S-2021) 

❖ The title bar will display the name of the application and the name of the document opened. 

❖ The menu bar is seen under the title bar. Menus in the menu bar can be accessed by pressing Alt key and the 

letter that appears underlined in the menu title. 

❖ The workspace is the area in the document window to enter or type the text of your document. 

❖ The scroll bars are used to scroll the workspace horizontally or vertically. 

❖ The corners and borders of the window helps to drag and resize the windows. 

4. Write the two ways to create a new folder. (M-2023)(M-2024) 

Method I:  
Step 1: Open Computer Icon.                         Step 2: Open any drive where you want to create a new folder.  

Step 3: Click on File → New → Folder.        Step 4: A new folder is created with the default name “New folder”.  

Step 5: Type in the folder name and press Enter key. 

Method II:  
Step 1: In the Desktop, right click → New → Folder.         Step 2: A Folder appears with the default name “New folder”. 

Step 3: Type the name you want and press Enter Key.        Step 4: The name of the folder will change. 

5. Write the procedure to create a file in word pad (AUG-2022) 

1. Click Start → All Programs → Accessories → Wordpad or Run → type Wordpad, click OK.  

Word pad window will be opened as folder. 

2. Type the contents in the workspace and save the file using File → Save or Ctrl + S. 

3. Save As dialog box will be opened.  

4. In the dialog box, select the location where you want to save the file by using look in drop down list box. 

5. Type the name of the file in the file name text box. 6.Click save button. 
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6. Compare CUT-PASTE and COPY- PASTE (M-2023) 

CUT and PASTE: 

 To move a file or folder, first select the file or folder and then choose one of the following: 

❖ Click on the Edit → Cut or Ctrl + X or right click → Cut from the pop-up menu. 

❖ To move the file(s) or folder(s) in the new location, navigate to the new location and paste it using Click Edit 

→ Paste or Ctrl + V or Right click → Paste from the popup menu.  

❖ The file will be pasted in the new location. 

COPY and PASTE:  

To copy a file or folder, first select the file or folder and then choose one of the following: 

❖ Click Edit → Copy or Ctrl + C or right click→ Copy from the pop-up menu. 

❖ To paste the file(s) or folder(s) in the new location, navigate to the target location and paste it using Click Edit 

→ Paste or Ctrl + V or Right click → Paste from the popup menu.  

❖ The file will be pasted in the new location 

7. Name the methods followed while copying files and folders to removable disk (S-2020) 

1. Copy 2.Drag and Drop 3. Send To 4. Copy and Paste using keyboard shortcuts 

8. How can you move a file one location to another location in windows? (J-2019) 

CUT and PASTE:  

❖ Click on the Edit → Cut or Ctrl + X Or right click → cut from the pop-up menu.  

❖ To move the file(s) or folder(s) in the new location, navigate to the new location and paste it using Click Edit 

→ Paste from edit menu or Ctrl + V using keyboard.  

❖ Or Right click → Paste from the pop-up menu. The file will be pasted in the new location. 

 CHAPTER – 6 Introduction to Word Processor 
1. What is the difference between moving and copying text?    (S-2021)                  

Moving text Copying text 

❖ Move the original text from one  location to 

another. 

❖ Copies the original text in as many places as 

necessary without moving from its location. 

❖ Click Ctrl + X or Cut Icon  or Edit –Cut ❖ Click Ctrl + C or Copy Icon or Edit -Copy 

❖ The text is removed from the source location and 

placed in the clipboard. 

❖ A duplicate copy of the text is made and send to 

the clipboard 
 

2. What are the different types of page orientation? (M-2019) 

❖ Page orientation refers to how the document will be displayed on screen and printed. 

❖ Landscape - The width of the document is more than the height. This is best suited for displaying professional 

photos, invitations, albums, tables etc. 

❖ Portrait – This is the most common and default orientation. Here, the height of the document is more than the width. 

3. How do you insert rows and columns? (M-2022)(M-2023) 

1. Place the insertion pointer in the row or in the column where you would like to add new rows or columns and right click. 

2. Choose Row -Insert – to insert a row or Column - Insert – to insert a column. 

3. A dialog box will appear, from which you can select the number of rows or columns to insert.  

4. You can also set the position of the new rows or columns to before or after. 

5. Click Ok to close the dialog box. 

4. What are the different ways to save a document? (S-2021, J-2024) 

1. Click File → Save (or) File → Save As (or) Ctrl + S 

2. The “Save As” dialog box appears as on screen. 

3. Select location to store your document.  

4. The default location to store all documents is “Documents” folder in Windows. 

5. Type your document name in the File Name box. 

6. All documents in Open Office Writer will be stored with .odt extension.  

7. You can store your Open Office document as Microsoft Word document or pdf.  

8. To do so, select file type from Save as type list box.  

9. This list box shows variety of formats to be saved. 

10. Finally, Click “Save” button. 

5. Write about auto correct option in Writer (S-2020) 

Automatic correction:  
❖ Auto Correct feature has the facility to correct the common misspellings and typing errors, automatically.  

❖ For example, “hte” will be changed to “the”, which can be done through the menu option, Tools → AutoCorrect to open 

the AutoCorrect dialog box which provides the chance to change the misspelled word with the correct word. 

To make an AutoCorrect entry 

• Select Tools → AutoCorrect                • AutoCorrect dialog box appears  • Click Replace Tab 

• In replace box, type the misspelt word  • In with box, the correct word      • Click New 

6. What is indenting text in writer? Write its types (J-2023) 

Indenting text: 

❖ Indent is the distance from the left and right margin of a paragraph.  
❖ It is used to improve the efficiency and readability of the paragraph and makes the paragraph look more attractive. 
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There are four types of indentations:  

• Left Indent   • Right Indent   • First Line Indent  • Hanging Indent. 

7. What are the different types of operators supported by calc? What is range? (S-2020) 

Types of operators: 

(1) Arithmetic Operators (2) Relational Operators (3) Reference Operators (4) Text Operator 

Range: 

❖ Reference operators are used to refer cell ranges.  

❖ A continuous group of cells is called as “Range”. 

 CHAPTER -7 Working with Open Office Calc 
1. Write a short note on Open Office Calc. (M-2020)                                      

❖ Open Office Calc is a popular open source spread sheet application maintained by Apache Foundation. 

❖ Star Office calc was the parent application of Open Office Calc which was developed by a German Company 

namely, Star Division in 1985. 

❖ Calc is the spread sheet component of Open Office.  

❖ You can enter any kind of data in a spread sheet and then manipulate this data to produce certain results. 

2. Write about inserting columns and rows in Calc. (M-2023) 

1.Inserting Rows : 

❖ Step 1: Select the row where a new row to be inserted. 

❖ Step 2: Right-click on the row number, a pop-up menu appears  

❖ Step 3: click “Insert Rows” option from the menu. 

❖ Now, a new row will be inserted to above the current row. 

❖ Insert -Rows command is used to insert a new row. 

2.Inserting a Column : 

❖ Step 1: Select the column where a new column should be inserted. 

❖ Step 2: Right-click on the selected column name that you selected.  

❖ Step 3: click the “Insert Columns” option from the menu. 

❖ Now, a new column will be inserted to the left of the current column.. 

3. In cell A1=34 A2=65 A3=89 write the formula to find the average. (M-2024) 

= AVERAGE (A1:A3)    (OR)   =SUM(A1:A3)/3  (OR)   =(A1+A2+A3)/3 

4. Write about date arithmetic (J-2019) 

❖ Manual date calculations can be tricky because you have to keep track of the number of days in a month.  

❖ In spread sheets, date calculations become very simple.  

❖ Here you can add a number to a date and arrive at a new date, find the difference between two dates and use a 

wide variety of function and formats to get what you want.  

❖ For example, enter a date 02/26/2018 in a cell, say A2.  

❖ Suppose you want to calculate the date 80 days after this date. To do so, enter the formula, = A2 + 80, in 

another cell, say A4. 

 CHAPTER- 8 Presentation Basics 
1. How many types of views are provided by Impress to its users? (M-2019)(S-2020)           

❖ Normal view - Normal view is the main view for creating individual slides. 

❖ Outline view - Outline view shows topic titles, bulleted lists and numbered list for each slide in outline format. 

❖ Notes view    - Notes view lets you add notes to each slide that are not seen when the presentation is shown. 

❖ Slide Sorter view - Slide Sorter view shows a thumbnail of each slide in order. 

❖ Hand out view – Hand out view lets you print your slides for a hand out. 

2. Define the Slide Sorter view and its significance. (M-2020) 

❖ Slide Sorter view shows a thumbnail of each slide in order.  
❖ Use this view to rearrange the order of slides, produce a timed slide show, or add transitions between selected slides. 

❖ Use this view to work with a group of slides or with only one slide. 

❖ Change the number of slides per row, if desired: 

      1) Check View → Toolbars → Slide View to show the Slide view toolbar. 

      2) Adjust the number of slides (up to a maximum of 15) 

3. What is a Normal view? Explain. (J-2023) 

❖ Normal view is the main view for creating individual slides. 

❖ Use this view to format and design slides and to add text, graphics and animation effects. 

❖ There are two ways to place a slide in the Slide Design area of the Normal view:  

❖ 1. Clicking the slide thumbnail in the Slides pane (or) 2.Using the Navigator. 

4. How will you start open office impress? (J-2019) 

❖ In order to open impress using Start button, click Start button and select All Programs → Open Office → 

Open Office Impress.  

❖ If it is already pinned in the Start menu, just click and open it. 

5. What are the three methods of inserting slide in impress presentation? (S-2020) 

Step 1: Insert a new slide. This can be done in a variety of ways. 

• Insert → Slide. 
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• Right-click on the present slide, and select Slide → New Slide from the pop-up menu.  

• Click the empty space after the last slide also to create a new slide by right clicking New Slide.  

• Click the Slide icon in the Presentation toolbar.  

Step 2: Select the layout slide that best fits your needs. (Figure 8.28). 

Step 3: Modify the elements of the slide like removing unneeded elements, adding, and inserting text. 

 CHAPTER- 9 Introduction to Internet and Email 

1. What is TCP/IP?   (M-2022)                                                                                  

❖ The Transmission Control Protocol/ Internet Protocol) to transmit data via various types of media. 

❖ The internet protocol (IP) addressing system is used to keep track of the millions of users. 

❖ The internet uses TCP/IP is a set of protocols that comprise hierarchies. 

2. Write a note on Hotspot internet service. (S-2020) 

❖ Hotspot is a physical location where people can access the Internet.  

❖ Internet access over a wireless local area network (WLAN) by way of a router that then connects to an Internet 

service provider.  

❖ Hotspots utilize Wi-Fi technology, which allows electronic devices to connect to the Internet or exchange data 

wirelessly through radio waves.  

❖ Hotspots can be phone-based or free-standing, commercial or free to the public. 

3. Differentiate Data Card and Dongles. (M-2020)(M-2023) 

Dongle Data Card 

Refers to any removable component used for enabling 

extra security.  

USB Dongles can be divided into  

1.WiFi Dongles 2.BlueTooth Dongle 

3.Memory Dongle 

It is a removable electronic card which is used for 

storing for data.  

Types of data card are 

1.Expansion Card 2.Memory Card or Flash Card 

3.Identification Card 
 

4. Differentiate Website and Webpage. (M-2019)(S-2021) 
 

                Webpage                    Website 
❖ Consists of a Single document displayed by a browser ❖ A collection of multiple documents displayable by a browser 

❖ Shares a unique domain name ❖ Has its own unique domain name 

❖ Makes up a website ❖ Contains one or more web pages 

5. What are Advantages of e-mail? (S-2022)(J-2023)(J-2024) 

1.Free delivery : 

❖ Sending an e-mail is virtually free, outside the cost of Internet service.  

❖ There is no need to buy a postage stamp to send a letter. 

2.Global delivery :  

❖ E-mail can be sent to nearly anywhere around the world, to any country.  

3.Instant delivery :  

❖ An e-mail can be instantly sent and received by the recipient over the Internet.  

4.File attachment:  

❖ An e-mail can include one or more file attachments, allowing a person to send documents, pictures, or other 

files with an e-mail. 

5.Long-term storage : 

❖ E-mails are stored electronically, which allows for storage and archival over long periods of time. 

6.Environmentally friendly: 

❖ Sending an e-mail does not require paper cardboard, or packing tape, conserving paper resources. 

6. What is W3C? (J-2019) 

❖ W3C stands for "World Wide Web Consortium."  
❖ The W3C is an international community that includes a full-time staff, industry experts, and several member organizations.  

❖ These groups work together to develop standards for the World Wide Web.  

❖ The World Wide Web Consortium (W3C) is an international organization committed to improving the web.  

❖ It is made up of several hundred member organizations from a variety of related IT industries.  

❖ W3C sets standards for the World Wide Web (WWW) to facilitate better communication ability and 

cooperation among all web stakeholders.  

❖ It was established in 1994 by the creator of the WWW, Tim Berners-Lee. 

 CHAPTER- 10 HTML - Structural Tags 
1. Explain the attributes available with <body> tag.   (M-2019) 

❖ The <body> tag defines the document’s body.  

❖ <body> tag contains several attributes. 

(i) Background Colour: bgcolor = color:   <body bgcolor = color_name/color_code>  

(ii) Body text Colour: text = color:  <body text = color_name/color_code> 

(iii) Background image: background=image: <body background = “image_name_with_extenstion”> 

(iv) Setting Margins: margin = value : <body leftmargin = value topmargin = value> 
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2. What are the attributes available in <html> tags? (M-2020)(M-2024) 
 

Attribute Value to be set to attribute                  Description 

1.Dir ltr  (align left-to-right) 

rtl  (align right-to-left) 

dir attribute specifies the direction of the text to be aligned within the 

entire document.It is  global attribute.  

2.Lang Predefined language code English – 

en Tamil – ta  

Telugu – te 

lang attribute specify the language used within the document.  

Malayalam – ml; Kannada – kn; Hindi – hi; French – fr; German – de; 

3. How do you view the source file? (S-2022) 

❖ Right click on the browser. 
❖ Select View Page Source (Firefox and Chrome) / View Source (Internet Explorer) or Press Ctrl + U (all browser)  

❖ Source file will be displayed. 

❖ In Internet Explorer, View → Source is also used to open source file. 

 CHAPTER- 11 HTML – Formatting text, Creating Tables, List and Links 
1. Briefly explain the attributes of <hr> tag.  (S-2021) (J-2023) 

❖ The <hr> tag having four attributes viz. size, width, no shade and color. 

1. Size:          Thickness of the horizontal line can be changed with size attribute.  

                        The size is given in terms of pixels.  

2. Width:       The width attribute specifies the horizontal width of the rule line. 

3. Noshade:   The default view of a horizontal rule line is 3D.  

4. Color: The horizontal line is displayed in gray color by default.  

Syntax:         <hr size=valuewidth=valuenoshade, color=color_name/code> 

2. What are the core tags used to create table in HTML? (M-2022) 

1. <table> tag is used to create a table.    2. <tr> tag defines table rows 

3. <th> tag defined table columns                  4. <td> tag is used to specify the data in a cell. 

5. <caption> tag defines title for the table. 
3. Difference between <UL> and <OL> tags. (M-2023) 

Un ordered list Ordered list 

❖ Unordered lists are often referred as bulleted 

lists.  

❖ Ordered list displays items in a numerical or alphabetical 

order within the tag pair <OL> …… /OL> tag.  

❖ Instead of numbers, each element in the list has 

prefixed with a special bullet symbol.  

❖ Each list element is defined by <LI> tag. 

❖ Unordered list is surrounded within <UL>… </UL> tags.  ❖ Both <OL> and <LI> tags are container tags. 

❖ Each list element is defined by <LI> tag ❖ No closing tag. 
 

4. What are the uses of <strong> and <em> tag? (S-2022) 

1.<strong> Important text: 

❖ The <strong> tag is a phrase tag.  

❖ It is used to define important text.  

❖ This tag displays the text as bold.  

2.<em> - Emphasized text:  

❖ The <em> tag is used to emphasize the text.  

❖ That means, when you use this tag, the text will be in italics. 

5. Write an HTML code to scroll the following message in a web page. (M-2019) 

“Welcome to HTML” 

<html> 

<head> 

<title> Marguee </title> 

</head> 

<body> 

<marguee > Welcome to HTML </marquee> 

</body> 

</html> 

 CHAPTER- 12 HTML – Adding multimedia elements and Forms 
1. Write a short note on familiar images format. (M-2020)                          

1.GIF (Graphical Interchange Format): 

❖ This format is one of the popular format for animated images. 

❖ JPEG is the most popular image format supported by all web browsers. 

❖ This format is suitable for presenting tiny animated images, logos, icons,etc., 

2.JPEG (Joint Photographic Experts Group): 

❖ This format is suitable for photographic images. 

❖ JPEG can include any number of colours. 

3.PNG (Portable Network Graphics): 

❖ PNG is designed as a replacement for GIF. 

❖ It is also supported by all browsers. 
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4.SVG (Scalable Vector Graphics)  

❖ SVG is a graphics format that was developed for web. 

❖ It was standardized by World Wide Web Consortium (W3C) in 2001. 

❖ All current web browsers supports basic features of SVG. 

2. Explain the main attributes used with <form> tag. (S-2020)(M-2022)(M-2024) 

Method: 
❖ The method attribute of the form tag is used to identify how the form element names and values will be sent to the server.  

❖ The get method will append the names of the form elements and their values to the URL. 

Action  

❖ The action attribute identifies the server side program or script that will process the form.  

❖ The action will be the name of a Common Gateway Interface (CGI) program written in programming 

languages like Perl, JavaScript, PHP or Active Server Pages (ASP). 

General Format of <form> tag  

<Form method=get/post action= “back_end_server_script”> 

Form elements  

</Form> 

3. Explain the values of <input> tag’s type attribute. (S-2022)(J-2023) 
 

1.Text Create a Text Box.  

The element used to get all kind of text input such as name, address. 

2.Password Similar as Text box. But, while entering data, the characters are appearing as coded symbols 

such as asterisk. 

3.Checkbox   

   Multi select box 

Check box is an element appearing like a small square box.  

4.RadioButton Radio button is used to select any one of the multiple options from the list.  

5.Reset It is a special command button used to clear all the entries made in the form. 

6.Submit It is also a special command button used to submit all the entries made in the form to the backend server. 

7.Button This is a standard graphical button on the form used to call functions on click. 

4. Explain the attributes of <select> and <option> tags. (J-2019)(S-2019)(S-2021) 

1.Attributes of <Select> tag: 

❖ Name – Provide the name to the control, which is sent to the server. 

❖ Size – Determine the style of dropdown list box.  

❖ Size = 1 dropdown list box  

❖ Size = 2 List box 

❖ Multiple – Allows user to select multiple values. 

2.Attributes of <Option> tag: 

1.Selected – Indicate default selection 

❖ Value – Value to be submitted to server 

 CHAPTER- 13 CSS – Cascading Style Sheets 
1. What are the advantages of using CSS?  (J-2019)(M-2019)(M-2024)                                 

1.Maintainability: 

❖ CSS are also defined and stored as separate files.  
❖ So, the style and appearance of a web page can be dynamically changed and maintain with less effort. 

2.Reusability :  

❖ The styles defined in CSS can be reused in multiple HTML pages. 

3.Easy to understand :  
❖ The tags in web pages are well organized with style specifications and therefore it is easy to understand 

2. Write a short note on rule of CSS. (J-2024) 

❖ CSS style declaration consists of two major parts; Selector and Declaration. 

❖ The Selector refers an HTML tag in which you want to apply styles.  

❖ The Declaration is a block of code contains style definition.  

❖ It should be surrounded by curly braces.  

❖ You can include any number of properties for each selector, and they must be separated by semicolons.  

❖ The property name and its value should be separated by a colon.  

❖ Each declaration should be terminated by a semicolon (;) 

3. Write a CSS file to define text color and alignment to <p> tag. (S-2020) 

P 

{ 

color:pink;  

Text-align : center; 

}  

 The above code can be saved para.css 
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Example: 
<html> 

<head> 

<title> Demonstration of using CSS </title> 

<link rel="stylesheet" type="text/css" href="mystyle.css"> 

</head> 

<body> 

<H1> Welcome to CSS </H1> 

<P>  

CSS was invented by HakonWium Lie on October 10, 1994 and maintained through a group of people within the W3C called 

the CSS Working Group. The CSS Working Group creates documents called specifications.  

</P> 

</body> 

</html> 

 CHAPTER- 14 Introduction to Java script 
1. Brief the basic data types in Java Scripts. (J-2023)(M-2024) 

❖ The basic data types in JavaScript are Strings, Numbers, and Booleans. 

1.String: 

❖ String is a list of characters a string literal is indicated by enclosing the characters in single (single character) 

or double quotes. 

2.Numbers: 

❖ Number can be integer or floating-point numerical value and numeric literals are specified in the natural way. 

3.Boolean: 

❖ Boolean can be any one of two values: true or false. 

❖ Boolean literals are indicated by using true or false directly in the source code 

2. Write note on string Operator (S-2021) 

❖ + Operator is also called as the string concatenation operator. 

❖ Because string concatenation has precedence over numeric addition, + will be interpreted as string 

concatenation if any of the operands are strings. 

Example:  String1:java       String2:script 

                  Concatenated string of string1 and string2:javascript 

3. Write about <script> tag. (M-2019)(J-2024) 

❖ The <script> …….</script> tag containing JavaScript can be placed anywhere within in the web 

page, but it is normally recommended that should be kept it within the <head> tags. 

❖ The <script> tag alerts the browser program to start interpreting all the text between these tags as a 

script commands. 

Syntax: 

<script language=”javascript” type=”text/javascript”> JavaScript code 

</script> 

❖ The <SCRIPT> tag takes two important attribute 1.language 2.type. 

4. Difference between the increment and Decrement operator. (S-2022) 

        Increment operator               Decrement operator 
❖ The ++ operator increments its single operand. ❖ The - - operator decrements its single operand 

❖ Its converts its operand to a number, 

adds 1 to that number, and assigns the 

incremented value back into the Operand 

❖ Its converts its operand to a number, subtracts 1 to 

that number, and assigns the decremented value 

back into the operand 

❖ Post increment: var m=3, n=m++; 

❖ Pre increment: var m=3, n=++; 

❖ Post decrement: var m=3, n=m--; 

❖ Pre decrement: var m=3, n=m--; 
 

5. Write the rules for naming a variable in java script (J-2019) 

❖ The first character must be a letter or an underscore (_). Number cannot be as the first character.  

❖ The rest of the variable name can include any letter, any number, or the underscore.  

❖ You can't use any other characters, including spaces, symbols, and punctuation marks. 

❖ JavaScript variable names are case sensitive.  
❖ That is, a variable named Register Number is treated as an entirely different variable than one named register number. 

❖ There is no limit to the length of the variable name. 

❖ JavaScript's reserved words cannot be used as a variable name.  

❖ All programming languages have a supply of words that are used internally by the language and that cannot be 

used for variable names.  

 

 

 

 

 

 

www.Padasalai.Net                                                  www.TrbTnpsc.com

Kindly Send Me Your Study Materials To Us Email ID:   padasalai.net@gmail.com

PadasalaiPadasalai

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m
https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m


23 

                                         PREPARED BY...,    B.MOHAMED YOUSUF M.C.A., B.Ed..,    (PG ASST IN COMPUTER SCIENCE) 

                                    [yousufaslan5855@gmail.com] 

 CHAPTER- 15 Control Structure in Java script 
1. Write the syntax for  else-if statement. (S-2021) 

If (condition 1)  

{   

   block 1;  

}  

else if (condition 2)  

{   

     block 2; }  

else if (condition 3)  

{  

   block 3;  

}  

else  

{  

   block 4; 

} 

2. What is called a loop and what are its types? (M-2020) (M-2022)(J-2024) 

❖ In JavaScript there are times when the same portion of code needs to be executed many times with slightly 

different values is called Loops.  

❖ JavaScript supports three kinds of looping statements.  

❖ They are 1. For loop, 2.while loop 3.do..while loop 

3. Differentiate between while and do while statements. (S-2020) (J-2023) 

            While          do while  

❖ Entry check loop ❖ Exit check loop 

❖ The condition is checked at the beginning of the 

body of the while loop and executes the loop 

repeatedly until the condition is TRUE. 

❖ The condition is checked at the end of the body of the 

do while loop. 

❖ Therefore, the body of the loop is executed at least 

once when the condition is evaluated as false. 

Syntax:  

while (condition)  

{  

body of the loop  

} 

Syntax : 

do  

{  

body of the loop  

} while (expression); 
 

4. What message will be displayed, if the input for age is given as 20, for the following snippet? (M-2019)   

Answer : 

if (age> = 18 )                                                    Message will be display like, 

{                                                                       you are eligible to get Driving licence 

alert (“you are eligible to get Driving licence”}         

}                                                                           

else                                                            

alert (“you are not eligible to get driving licence”);  

 } 

5. List out various branching statements in java script (M-2023) 

• if statement  • if … else statement  • else if statement • switch statement 

 

6. Write a syntax of if statement (S-2021) 

if (condition)  

{                                              

True block;                       

} 

7. What message will be displayed, if the input marks is given as 60, for the following snippet? (J-2019)   

if (marks> = 40 )                                                    Message will be display like, 

{                                                                                    you have passed 

alert (“you have passed”}         

}                                                                           

else                                                            

alert (“you have failed”);  

 } 
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 CHAPTER- 16 JavaScript Functions 
1. Write the syntax of functions (S-2020) 

Function function-name(parameters list)  

{ 

       Declaration of variable 

       Executable statements;         Function Body 

} 

2. Describe any three pre-defined functions in JavaScript with examples (M-2022) 

Function Description Example Result 

toUpperCase() Used to convert given string into uppercase  x=”java” 

x.toUpperCase(); 

JAVA 

toLowerCase() Used to convert given string into lowercase x=”JAVA” 

x.toLowerCase(); 

java 

length Used to find length of the given string x=”JAVA” x.length(); 4 

parseInt() Used to convert the given float value into an integer parseInt(34.234); 34 

parseFloat() Used to convert the given string into a integer parseInt(“34.23”); 34.23 
 

3. What is function in java script? Write its types. (M-2024) 

Function: 
❖ A function is a block of java script code that is defined once but may be executed or invoked any number of times. 

❖ Java script supports two types of functions, 1.Predefined or library functions 2.User-defined functions 

 CHAPTER – 17 Computer Ethics and Cyber Security 
1. Write about encryption and decryption. (M-2023) 

Encryption: 

❖ Processes that ensure confidentiality that only authorized persons can access the information. 

❖ The process of translating the plain text data into random and mangled data. 

❖ Used by militaries and governments to facilitate secret communication. 

Decryption: Reverse process of converting the cipher-text back to plaintext. 

2. What are ethical issues? Name some. (M-2020)(S-2022) 

❖ An Ethical issue is a problem or issue that requires a person or organization to choose between alternatives that 

must be evaluated as right (ethical) or wrong (unethical).  

Some of the common ethical issues are listed below: 

1. Cyber-crime 2) Software Piracy 3) Unauthorized Access 4) Hacking 5) Use of computers to commit fraud 6) 

Sabotage in the form of viruses 7) Making false claims using computers. 

3. Write a short note on cracking.  (M-2023) 

❖ Cracking” means trying to get into computer systems in order to steal, corrupt, or illegitimately view data. 

❖ Cracking is where someone edits a program source so that the code can be exploited or modified. 

❖ A cracker is a malicious or criminal hacker. 

 CHAPTER – 18 (Tamil Computing) 

1. Write a short note on Tamil virtual Academy. (M-2023) 

❖ With the objectives of spreading Tamil to the entire world through internet, Tamil Virtual University was 

established by the Govt. of Tamilnadu. 

❖ This organization functions with the name of “Tamil Virtual Academy”. 

❖ It offers different courses in Tamil language, Culture, heritage etc., 

2. Define – Unicode (S-2020) 

❖ Unicode is an encoding system, designed to handle various world languages, including Tamil.  

❖ Its first version 1.0.0 was introduced in October 1991.  

❖ Unicode is the best suitable to handle Tamil. 
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     CHAPTER 1 TO 17 five-mark public QUESTION with ANSWERS [MARCH-2019 TO JULY-2024] 
 CHAPTER – 1 Introduction to Computers 

1. Explain the basic components of a computer with a neat diagram.  (M-2019) (S-2020) (S-2022)   

❖ The computer is the combination of hardware and software.  

❖ Hardware is the physical component of a computer like motherboard, memory devices, monitor, keyboard etc.,  

❖ Software is the set of programs or instructions.  

❖ Both hardware and software together make the computer system to function.       

❖ Every task given to a computer follows an Input- Process- Output Cycle (IPO cycle).  

❖ It needs certain input, processes that input and produces the desired output.   

 
Input Unit  
❖ Input unit is used to feed any form of data to the computer, which can be stored in the memory unit for further processing.  

❖ Example: Keyboard, mouse, etc. 

Central Processing Unit (CPU): 

❖ CPU is the major component which interprets and executes software instructions. 

❖ It also controls the operation of all other components such as memory, input and output units. 

❖ The CPU has three components which are Control unit, Arithmetic and logic unit (ALU) and Memory unit. 

1.Arithmetic and Logic Unit: 

❖ The ALU is a part of the CPU where various computing functions are performed on data. 
❖ The ALU performs arithmetic operations such as addition, subtraction, multiplication, division and logical operations. 

❖ The logical operations of ALU promote the decision-making ability of a computer. 

2.Control Unit: 

❖ The control unit controls the flow of data between the CPU, memory and I/O devices. 

❖ It also controls the entire operation of a computer. 

3.Output Unit: 

❖ An Output Unit is any hardware component that conveys information to users in an understandable form. 

❖ Example: Monitor, Printer etc. 

4.Memory Unit: 

❖ The Memory Unit is of two types which are primary memory and secondary memory. 

❖ The primary memory is used to temporarily store the programs and data. 

❖ The secondary memory is used to store the data permanently. 

❖ The Primary Memory is volatile, the Random Access Memory (RAM) is an example of a main memory. 
❖ The Secondary memory is non-volatile, hard disk, CDROM and DVD ROM are examples of secondary memory. 

2. Discuss the various generations of computers. (J-2019) (M-2020) (S-2021) (M-2022) (M-2023) (J-2024) 

Generation & 

Period       

Main Component 

used 

            Merits/Demerits 

First 

Generation 

1940-1956 

Vacuum tubes ❖ Big in size 

❖ Consumed more power 

❖ Malfunction due to overheat 

❖ Machine Language was used 

Second 

Generation 

1956-1964 

Transistors 

 

❖ Smaller compared to First Generation 

❖ Generated Less Heat 

❖ Consumed less power compared to first generation 

❖ Punched cards were used 

❖ First operating system was developed – Batch Processing and 

Multiprogramming Operating System 

❖ Assembly language was used. 

Third 

Generation 

   1964-1971 

 

Integrated 

Circuits (IC) 

 

❖ Computers were smaller, 

❖ faster and more reliable 

❖ Consumed less power 

❖ High Level Languages were used 

Fourth 

Generation 

1971-1980 

Microprocessor 
Very Large Scale 

Integrated Circuits  (VLSI) 

❖ Smaller and Faster 

❖ Microcomputer series such as IBM and APPLE were developed 

❖ Portable Computers were introduced. 
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Fifth 

Generation 

1980 – till 

date 

Ultra Large Scale 

Integration(ULSI) 

 

❖ Parallel Processing  

❖ Super conductors 

❖ Computers size was drastically reduced. 

❖ Can recognise Images and Graphics 

❖ Introduction of Artificial Intelligence and Expert Systems  

❖ Able to solve high complex problems including decision making 

and logical reasoning 
Sixth 

Generation 

In future 

 

❖ Parallel and Distributed computing 

❖ Computers have become smarter, faster and smaller 

❖ Development of robotics 

❖ Natural Language Processing 

❖ Development of Voice Recognition Software 
 

3. Explain the following a. Inkjet Printer b. Multimedia projector c. Bar code / QR code Reader (J-2023) (M-2024) 

1.Inkjet Printers:                                                                                                                       

❖ Inkjet Printers use colour cartridges which combined Magenta, Yellow and Cyan inks to create colour tones.  
❖ A black cartridge is also used for monochrome output. Inkjet printers work by spraying ionised ink at a sheet of paper.  

❖ The speed of Inkjet printers generally range from 1-20 PPM (Page Per Minute). 

❖ A tiny electric currents controlled by electronic circuits are used inside the printer to spread ink in jet speed. 

❖ An Inkjet printer can spread millions of dots of ink at the paper every single second. 

2.Multimedia Projectors:  

❖ Multimedia projectors are used to produce computer output on a big screen. 

❖ These are used to display presentations in meeting halls or in classrooms. 

3. i) Bar Code / QR Code Reader:  

❖ A Bar code is a pattern printed in lines of different thickness.  

❖ The Bar code reader scans the information on the bar codes transmits to the Computer for further processing.  

❖ The system gives fast and error free entry of information into the computer. 

ii) QR (Quick response) Code:  
❖ The QR code is the two dimension bar code which can be read by a camera and processed to interpret the image. 

4. Explain Data and information (M-2022) 

Data:  
❖ Data is defined as a un- processed collection of raw facts, suitable for communication, interpretation or processing.  

❖ For example, 134, 16 ‘Kavitha’, ‘C’ are data.  

❖ This will not give any meaningful message.  

Information:  

❖ Information is a collection of facts from which conclusions may be drawn.  
❖ In simple words we can say that data is the raw facts that is processed to give meaningful, ordered or structured 

information.  

❖ For example Kavitha is 16 years old.  

❖ This information is about Kavitha and conveys some meaning.  

❖ This conversion of data into information is called data processing. 

 CHAPTER – 2 Number Systems 

1. a) Write the procedure to convert fractional Decimal to Binary. (M-2020) (M-2023)         

❖ The method of repeated multiplication by 2 has to be used to convert such kind of decimal fractions. 

The steps involved in the method of repeated multiplication by 2: 

• Step 1: Multiply the decimal fraction by 2 and note the integer part.  

o The integer part is either 0 or 1. 

• Step 2: Discard the integer part of the previous product.  

o Multiply the fractional part of the previous product by 2.  

o Repeat Step 1 until the same fraction repeats or terminates (0). 

• Step 3: The resulting integer part forms a sequence of 0s and 1s that become the binary equivalent of decimal fraction. 

• Step 4: The final answer is to be written from first integer part obtained till the last integer part obtained. 

b) Convert  (98.46)10  to binary: (M-2023)  

I.Integer Part:                    II. Fractional Part:      Integer     

2  98      98 = (1100010)2        0.46x2= 0.92                   = 0 

2  49-0                                  0.92x2= 1.84                   = 1           (46)10 = (.0110010)2 

2  24-1                                  0.84x2= 1.68                   = 1 

2  12-0                                 0.68x2= 1.36                    = 1           (98.46)10 = (1100010.0111010….)2 

2  6-0                                    0.36x2 = 0.72                  = 0 

2  3-0                                    0.72x2= 1.44                   = 1 

    1-1                                    0.44x2= 0.88                   = 0 

www.Padasalai.Net                                                  www.TrbTnpsc.com

Kindly Send Me Your Study Materials To Us Email ID:   padasalai.net@gmail.com

PadasalaiPadasalai

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m
https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m


27 

                     PREPARED BY...,    B.MOHAMED YOUSUF M.C.A., B.Ed..,    (PG ASST IN COMPUTER SCIENCE) 

                        [yousufaslan5855@gmail.com] 

2. Find 1’s Complement and 2’s Complement for the following Decimal number a) -98  b)- 135     (J-2024)                                               

2  98                        (98)             1100010 

2  49-0                      8 bit                   01100010 

2  24-1                      1’s compliment                10011101 

2  12-0                         (-98)              (10011110)2 

2  6-0 

2  3-0 

    1-1 

       1  

1’s 1 0 0 1 1 1 0 1 

        1 

2’s 1 0 0 1 1 1 1 0 

b) (-135)                                                                                   

2  135                        (135)                    10000111 

2  67-1                      8 bit                    10000111 

2  33-1                      1’s compliment                   01111000 

2  16-1                       2’s compliment                01111001 

2  8-0                            (-135)        (01111001)2 

2  4-0 

2  2-0 

    1-0 

         

1’s 0 1 1 1 1 0 0 0 

        1 

2’s 0 1 1 1 1 0 0 1 
 

3. a) Add  11010102 + 1011012   (S-2020) (M-2023)                             

 1 1  1     

  1 1 0 1 0 1 0 

   1 0 1 1 0 1 

+ 1 0 0 1 0 1 1 1 

11010102+1011012  = 100101112 

 

b. Subtract 11010112 – 1110102 

  0 10 10     

  1 1 0 1 0 1 1 

   1 1 1 0 1 0 

-  0 1 1 0 0 0 1 

11010112  - 1112 =  1100012 

4. 1) Find the 2’s complement of (-46)10  2) Convert (145)8 to binary (S-2020) (J-2023) 

1. (-46) 

2  46                         (46)               101110 

2  23-0                      8 bit                00101110 

2  11-1                      1’s compliment                 11010001 

2   5-1 

2   2-1 

     1-0 

       1  

1’s 1 1 0 1 0 0 0 1 

        1 

2’s 1 1 0 1 0 0 1 0 

(-46)        11010010 

2) Convert (145)8 to binary 

(145)8   ( ? )2 

1          4         5         

 

001      100     101        (145)8 = (001100101)2 
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5. Covert the following Decimal numbers to its equivalent Binary, Octal, Hexadecimal (M-2019)(M-2022) 

1)  1920   2) 255   3) 126 

1. (1920)10  = ( ? )2 

Step :1 

2  1920         (1920)10 = (11110000000)2 

2  960-0        Step :2   (Binary to Octal) 

2  480-0                 (11110000000)2   (?)8            

2  240-0                 011  110  000  000              (1920)10 = (3600)8 

2  120-0                   3      6      0       0 

2  60-0 

2  30-0            Step : 3  (Binary to Hexa Decimal) 

2  15-0                   (11110000000)2   (?)16 

2  7-1                    0111  1000  0000              (1920)10 = (780)16 

2  3-1                     7          8        0  

    1-1 

2. (255)10  = ( ? )2 

Step :1 

2  255        (255)10 = (11111111)2 

2  127-1        Step :2   (Binary to Octal) 

2  63-1                 (11111111)2   (?)8            

2  31-1                 011  111  111             (255)10 = (377)8 

2  15-1                  3      7      7        

2  7-1 

2  3-1           Step : 3  (Binary to Hexa Decimal) 

    1-1                    (11111111)2   (?)16 

                            1111  1111               (255)10 = (FF)16 

                              F          F       

3. (126)10  = ( ? )2 

Step :1 

2  126        (126)10 = (1111110)2 

2  63-0        Step :2   (Binary to Octal) 

2  31-1                 (1111110)2   (?)8            

2  15-1                 011  111  110             (126)10 = (376)8 

2  7-1                    3      7        6       

2  3-1 

2  1-1           Step : 3  (Binary to Hexa Decimal) 

                                 (1111110)2   (?)16 

                            0111  1110               (126)10 = (7E)16 

                             7          E        

6. Convert (155)10 into Binary, Octal and Hexadecimal equivalent (M-2019) 

Step: 1                                  

2 155   (155)10 = (10011011)2 

2 77-1        Step: 2 

2 38-1         8  155      (155)10 = (233)8       Step: 3  

2 19-0         8  16-3                                         16  155            (155)10 = (9B)16    (11=b) 

2 9-0                2-3                                                 9-11 

2 4-1 

2 2-0 

    1-0 

7. Find 1’s Complement and 2’s Complement for the following Decimal number a) -89 b)- 128  (J-2019)                                               

2  89                        (-89)             1011001 

2  44-1                      8 bit                01011001 

2  22-0                     1’s compliment                    10100110 

2  11-0                         (-89)              (10100111 )2 

2  5-1 

2  2-1 

    1-0 

         

1’s 1 0 1 0 0 1 1 0 

        1 

2’s 1 0 1 0 0 1 1 1 
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b) (-128)                                                                                   

2  128                        (-128)      10000000 

2  64-0                      8 bit                   10000000 

2  32-0                      1’s compliment                    011111111 

2  16-0                       2’s compliment                  01111001 

2  8-0                            (-128)        (10000000)2 

2  4-0 

2  2-0 

    1-0 

 1 1 1 1 1 1 1  

1’s 0 1 1 1 1 1 1 1 

        1 

2’s 1 0 0 0 0 0 0 0 
 

8. a) Convert  (58.36)10  to binary: (J-2023) 

I.Integer Part:                    II. Fractional Part:      Integer     

2  58      58 = (111010)2           0.36x2= 0.72                   = 0 

2  29-0                                  0.72x2= 1.44                   = 1           (58)10 = (.011101)2 

2  14-1                                  0.44x2= 0.88                   = 1 

2  7-0                                   0.88x2= 1.76                    = 1           (58.36)10 = (111010.011101….)2 

2  3-1                                   0.76x2 = 1.52                  = 0 

2  1-1                                    0.52x2= 1.04                   = 1 

b) Find the 2’s complement of (-55)10  

2  55                         (-55)               101101 

2  22-1                      8 bit                00101101 

2  11-0                      1’s compliment                11010010 

2   5-1 

2   2-1 

     1-0 

         

1’s 1 1 0 1 0 0 1 0 

        1 

2’s 1 1 0 1 0 0 1 1 

(-55)        11010011 

9. b) Convert  (98.42)10  to binary: (M-2020)  

I.Integer Part:                    II. Fractional Part:      Integer     

2  98      98 = (1100010)2        0.42x2= 0.84                   = 0 

2  49-0                                  0.84x2= 1.68                   = 1           (42)10 = (.011101)2 

2  24-1                                  0.68x2= 1.36                   = 1 

2  12-0                                 0.36x2= 0.72                    = 1           (98.42)10 = (1100010.011101….)2 

2  6-0                                    0.72x2 = 1.44                  = 0 

2  3-0                                    0.44x2= 0.88                   = 1 

    1-1                              

10. a) Convert  (58.46)10  to binary: (M-2024) 

I.Integer Part:                    II. Fractional Part:      Integer     

2  58      58 = (111010)2           0.46x2= 0.92                   = 0 

2  29-0                                  0.92x2= 1.84                   = 1           (58)10 = (.0111010)2 

2  14-1                                  0.84x2= 1.68                   = 1 

2  7-0                                   0.68x2= 1.36                    = 1           (58.46)10 = (111010.0111...….)2 

2  3-1                                   0.36x2 = 0.72                  = 0 

2  1-1                                    0.72x2= 1.44                   = 1 

11. b) Write the 1’s complement number and 2’s complement number for the following decimal numbers: (M-2024) 

1) (-24) 

2  24        - 24     = 110002 

2  12-0     8 bit   = 00011000 

2  6-0       1s      = 111001112 

2  3-0                                  1 

    1-1       2s      = 111010002 
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2) (- 65) 

2  65          -65 = 100000012 

2  32-1       8bit = 01000001 

2  16-0       1s   = 101111102              

2  8-0                                 1  

2  4-0         2s   = 101111112 

2  2-0 

    1-0 

 CHAPTER – 3 Computer Organization 

1. Explain the characteristics of a microprocessor. (J-2019)(M-2020) (J-2023) (J-2024)                            

❖ A Microprocessor’s performance depends on the following characteristics:  

         a) Clock speed           b) Instruction set        c) Word size 

a) Clock Speed:  

❖ Every microprocessor has an internal clock that regulates the speed at which it executes instructions.  

❖ The speed at which the microprocessor executes instructions is called the clock speed.  

❖ Clock speed is measured in MHz (Mega Hertz) or in GHz (Giga Hertz). 

b) Instruction Set:  

❖ A command which is given to a computer to perform an operation on data is called an instruction.  
❖ Basic set of machine level instructions that a microprocessor is designed to execute is called as an instruction set.  

❖ This instruction set carries out the following types of operations:  

1.Data transfer, 2.Arithmetic operations, 3.Logical operations, 4.Control flow , 5.Input/output  

c) Word Size:  

❖ The number of bits that can be processed by a processor in a single instruction is called its word size.  

❖ Word size determines the amount of RAM that can be accessed by a microprocessor. 

2. Arrange the memory devices in ascending order based on the access time. (S-2020) (M-2023) 

 
Blu-Ray Disc:  

❖ Blu-Ray Disc is a high-density optical disc similar to DVD.  

❖ Blu-ray is the type of disc used for PlayStation games and for playing High-Definition (HD) movies. 

❖ A double-layer Blu-Ray disc can store up to 50GB (gigabytes) of data.  

❖ DVD uses a red laser to read and write data. But, Blu-ray uses a blue-violet laser to write.  

❖ Hence, it is called as Blu-Ray. 

Cache Memory : 
❖ The cache memory is a very high speed and expensive memory, which is used to speed up the memory retrieval process.  

❖ Due to its higher cost, the CPU comes with a smaller size of cache memory compared with the size of the main memory. 

Random-Access Memory (RAM): 

❖ The main memory is otherwise called as Random Access Memory.  

❖ It is the place in a computer where the Operating System, Application Programs and the data in current use are 

kept temporarily so that they can be accessed by the computer’s processor.  

❖ The smallest unit of information that can be stored in the memory is called as a bit.  

❖ RAM is a volatile memory 

Hard Disk : 

❖ Hard disk is a magnetic disk on which you can store data.  

❖ The hard disk has the stacked arrangement of disks accessed by a pair of heads for each of the disks.  

❖ The hard disks come with a single or double sided disk. 

3. Explain the types of ROM. (S-2021)(M-2022)(M-2024) 

Read only memory(ROM) 

❖ Read Only Memory refers to special memory in a computer with pre-recorded data at manufacturing time 

which cannot be modified.  

❖ The stored programs that start the computer and perform diagnostics are available in ROMs.  

❖ ROM stores critical programs such as the program that boots the computer.  

❖ Once the data has been written onto a ROM chip, it cannot be modified or removed and can only be read. 

❖ ROM retains its contents even when the computer is turned off. So, ROM is called as a non-volatile memory. 

1.PROM: 

❖ Programmable read only memory is also a non-volatile memory on which data can be written only once.  

❖ Once a program has been written onto a PROM, it remains there forever.  

❖ Unlike the main memory, PROMs retain their contents even when the computer is turned off.  

❖ The PROM differs from ROM.  
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❖ PROM is manufactured as a blank memory, whereas a ROM is programmed during the manufacturing process itself.  

❖ PROM programmer or a PROM burner is used to write data to a PROM chip.  

❖ The process of programming a PROM is called burning the PROM. 

2.EPROM: 

❖ Erasable Programmable Read Only Memory is a special type of memory which serves as a PROM, but the 

content can be erased using ultraviolet rays.  

❖ EPROM retains its contents until it is exposed to ultraviolet light.  

❖ The ultraviolet light clears its contents, making it possible to reprogram the memory.  

❖ An EPROM differs from a PROM, PROM can be written only once and cannot be erased.  

❖ EPROMs are used widely in personal computers because they enable the manufacturer to change the contents 

of the PROM to replace with updated versions or erase the contents before the computer is delivered. 

3.EEPROM: 

❖ Electrically Erasable Programmable Read Only Memory can be erased by exposing it to an electrical charge. 

❖ Like other types of PROM, EEPROM retains its contents even when the power is turned off.  

❖ Comparing with all other types of ROM, EEPROM is slower in performance. 

4. Explain any three secondary storage devices. (J-2019) 

1.Hard Disk : 

❖ Hard disk is a magnetic disk on which you can store data.  

❖ The hard disk has the stacked arrangement of disks accessed by a pair of heads for each of the disks. 

❖ The hard disks come with a single or double sided disk. 

2.Compact Disc (CD): 

❖ A CD or CD-ROM is made from 1.2 millimetres thick, polycarbonate plastic material.  

❖ A thin layer of aluminium or gold is applied to the surface.  

❖ CD data is represented as tiny indentations known as “pits”, encoded in a spiral track moulded into the top of 

the polycarbonate layer.  

❖ The areas between pits are known as “lands”.  

❖ A motor within the CD player rotates the disk.  

❖ The capacity of an ordinary CD-ROM is 700MB. 

3.Digital Versatile Disc (DVD):  

❖ A DVD (Digital Versatile Disc or Digital Video Disc) is an optical disc capable of storing up to 4.7 GB of 

data, more than six times what a CD can hold.  

❖ DVDs are often used to store movies at a better quality.  

❖ Like CDs, DVDs are read with a laser.  

❖ The disc can have one or two sides, and one or two layers of data per side; the number of sides and layers 

determines how much it can hold.  
❖ Double-layered sides are usually gold-coloured, while single-layered sides are usually silver-coloured, like a CD. 

4.Flash Memory Devices:  

❖ Flash memory is an electronic (solid-state) non-volatile computer storage medium that can be electrically 

erased and reprogrammed.  

❖ They are either EEPROM or EPROM.  

❖ Examples for Flash memories are pen drives, memory cards etc.  

❖ Flash memories can be used in personal computers, Personal Digital Assistants (PDA), digital audio. 

4.Blu-Ray Disc:  

❖ Blu-Ray Disc is a high-density optical disc similar to DVD.  

❖ Blu-ray is the type of disc used for PlayStation games and for playing High-Definition (HD) movies. 

❖ A double-layer Blu-Ray disc can store up to 50GB (gigabytes) of data.  

❖ DVD uses a red laser to read and write data. But, Blu-ray uses a blue-violet laser to write.  

 CHAPTER – 4 Theoretical Concepts of Operating System 

1. Explain the concept of a Distributed Operating System along with its advantages (M-2019)(S-2022)(M-2020) (J-2024)                                                                                                      
❖ The Distributed Operating System is used to access shared data and files that reside in any machine around the world.  

❖ The user can handle the data from different locations. 

❖ The users can access as if it is available on their own computer. 

Advantages : 

❖ A user at one location can make use of all the resources available at another location over the network. 

❖ Many computer resources can be added easily in the network 

❖ Improves the interaction with the customers and clients.  

❖ Reduces the load on the host computer.                                                                                                                 

2. List out the points to be noted while creating a user interface for an Operating system. (M-2019)(S-2021 b)(M-2024) 

❖ The user interface should enable the user to retain this expertise for a longer time.            

❖ The user interface should also satisfy the customer based on their needs. 

❖ The user interface should save user’s precious time.  

❖ The ultimate aim of any product is to satisfy the customer.  

❖ The User Interface is also to satisfy the customer. 

❖ The user interface should reduce number of errors committed by the user. 
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3. Explain the process management algorithms in Operating System. (M-2020)(S-2020)(M-2023) (J-2024) 

❖ Process management is function that includes creating and deleting processes (program) and providing 

mechanisms for processes to communicate and synchronize with each other.  

❖ A system task, such as sending output to a printer or screen, can also be called as a Process.  

The following algorithms are mainly used to allocate the job (process) to the processor.  

1. FIFO    2. SJF    3. Round Robin     4. Based on Priority 

1.FIFO (First In First Out)Scheduling:  

❖ This algorithm is based on queuing technique.  
❖ Technically, the process that enters the queue first is executed first by the CPU, followed by the next and so on.  

❖ The processes are executed in the order of the queue (row). 

Example: Assume that a student is standing in a queue (Row) to get grade sheet from his/her teacher, according to 

the order of the queue that is first in first out. 

2.SJF (Shortest Job First)Scheduling:  

❖ This algorithm works based on the size of the job being executed by the CPU.  

Example:  Consider two jobs A and B.  1) A = 6 kilo bytes           2) B = 9 kilo bytes  

❖ First the job “A” will be assigned and then job “B” gets its turn. 

3.Round Robin Scheduling : 

❖ The Round Robin (RR) scheduling algorithm is designed especially for time sharing systems.  

❖ Jobs (processes) are assigned and processor time in a circular method.  

Example:  Take three jobs A, B, C.  

❖ First the job A is assigned to CPU then job B and job C and then again A, B and C and so on. 

4.Based On Priority:  

❖ The given job (process) is assigned based on a Priority.  

❖ The job which has higher priority is more important than other jobs.  

Example: Take two jobs A and B. Let the priority of A be 5 and priority B be 7. 

❖ Job B is assigned to the processor before job A. 

4. Classify operating system based on the availability. (S-2020) 

Single User Operating Systems:  

❖ An operating system allows only a single user to perform a task at a time.  

❖ It is called as a Single user and single Task operating system. 

❖ MS-DOS is an example for a single user and single task Operating System. 

Multi-user Operating Systems: 

❖ It is used in computers and laptops that allow same data and applications to be accessed by multiple users at 

the same time.  

❖ The users can also communicate with each other.  

❖ Windows, Linux and UNIX are examples for multi-user Operating System. 

5. Explain the different types of software (J-2019) 

Types of Software: 

❖ Software is classified into two types:  1) Application Software  2) System Software  

1.Application Software:  

❖ Application software is a set of programs to perform specific task.  

❖ For example MS-word is an application software to create text document and VLC player is familiar 

application software to play audio, video files and many more.  

2.System Software:  
❖ System software is a type of computer program that is designed to run the computer’s hardware and application programs.  

❖ Example Operating System and Language Processor 

6. What is an user inter face? (S-2021 a) ) 

User Interface (UI):  

❖ User interface is one of the significant feature in Operating System.  

❖ The only way that user can make interaction with a computer.  

❖ This is a main reason for key success of GUI (Graphical User Interface) based Operating System. 

❖ The GUI is a window based system with a pointing device to direct I/O, choose from menus, make selections 

and a keyboard to enter text. 

❖ Its vibrant colours attract the user very easily 

 CHAPTER – 5 Working with Windows Operating System 

1. Explain the versions of Windows Operating System.   (S-2020) (M-2022) (M-2023)     

Versions Logo Year Specific features 

Windows  

1.x  
MICROSOFT 

WINDOWS 

1985 ❖ Introduction of GUI in 16 -–bit. processor  

❖ Mouse was introduced as an input device. 

Windows 

2.x  
MICROSOFT 

WINDOWS 

1987 ❖ Supports to minimize or maximize windows.  

❖ Control panel feature was introduced with various system settings 

and customising options. 
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Windows  

3.x  
MICROSOFT 
WINDOWS 

1992 ❖ Introduced the concept of multitasking.  

❖ Supported 256 colours which brought a more modern, colourful look 

to the interface. 

Windows 

NT  
MICROSOFT 

WINDOWS 

1993 ❖ Designed to act as servers in network. 

Windows 

95  
MICROSOFT 
WINDOWS 

1995 ❖ Introduced Start button, the taskbar, Windows Explorer and Start 

menu.  

❖ Introduced 32 -–bit processor and focused more on multitasking. 

Windows 

98  
MICROSOFT 

WINDOWS 

1998 ❖ Integration of the Web browser (Internet Explorer) with the Operating 

System.  

❖ DOS gaming began to disappear as Windows based games improved.  

❖ Plug and play feature was introduced. 

Windows 

Me 
 
2000 ❖ It introduced automated system diagnostics and recovery tools. 

Windows 

2000 

 

2000 ❖ Served as an Operating System for business desktop and laptop 

systems.  
❖ Four versions of Windows 2000 were released: Professional (for business 

desktop and laptop systems), Server (both a Web server and an office 

server), Advanced Server (for line-of-business applications) and Data Centre 

Server (for high-traffic computer networks). 

Windows 

XP 
 

2001 ❖ Introduced 64-bit Processor. 
❖ Improved Windows appearance with themes and offered a stable version. 

Windows 

Vista  

2006 ❖ Updated the look and feel of Windows. 

Windows 

7 

 

2009 ❖ Booting time was improved,  

❖ Introduced new user interfaces like Aero Peek, pinning programs to 

taskbar, handwriting recognition etc. and Internet Explorer 8 

Windows 

8  
2012 ❖ Windows 8 is faster than previous versions of Windows.  

❖ Start button was removed.  

❖ Windows 8 takes better advantage of multi-core processing, solid 

state drives (SSD), touch screens and other alternate input methods.  

❖ Served as common platform for mobile and computer. 

Windows 

10 

 

2015 ❖ Start Button was added again.  

❖ Multiple desktop.  

❖ Central Notification Center for App notification and quick actions.  

❖ Cortana voice activated personal assistant. 
 

2. Explain the different ways of finding a file or Folder:  (M-2024) 

To find a file or folder: 

❖ Click the Start button, the search box appears at the bottom of the start menu.  

❖ Type the name of the file or the folder you want to search.  
❖ Even if you give the part of the file or folder name, it will display the list of files or folders starting with the specified name.  

❖ The files or the folders with the specified names will appear, if you click that file, it will directly open that file or the folder. 

❖ There is another option called “See more results” which appears above the search box.  
❖ If you click it, it will lead you to a Search Results dialog box where you can click and open that file or the folder. 

Searching Files or folders using Computer icon: 

❖ Click Computer Icon from desktop or from Start menu.  
❖ The Computer disk drive screen will appear and at the top right corner of that screen, there is a search box option.  

❖ Type the name of the file or the folder you want to search.  
❖ Even if you give the part of the file or folder name, it will display the list of files or folders starting with the specified name. 

❖ Just click and open that file or the folder 

3. Explain about the different mouse actions (M-2019) 

Action Reaction 

Point to an item Move the mouse pointer over the item. 

Click  Point to the item on the screen, press and release the left mouse button. 

Right click  Point to the item on the screen, press and release the right mouse button. Clicking the 

right mouse button displays a pop up menu with various options. 

Double-click  Point to the item on the screen, quickly press twice the left mouse button. 
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4. Write the procedure to copy and paste files and folders to removable disk (S-2020) 

METHOD I -–Copy and Paste 

❖ Plug the USB flash drive directly into an available USB port 

If the USB flash drive or external drive folder does NOT open automatically, follow these steps: 

❖ Click Start→Computer 

❖ Double-click on the Removable Disk associated with the USB flash drive. 

❖ Navigate to the folders in your computer containing files you want to transfer. 

❖ Right-click on the file you want to copy, then select Copy. 

❖ Return to the Removable Disk window, right-click within the window, then select Paste. 

METHOD II -–Send To  

❖ Plug the USB flash drive directly into an available USB port. 

❖ Navigate to the folders in your computer containing files you want to transfer. 

❖ Right-click on the file you want to transfer to your removable disk. 

❖ Click Send To and select the Removable Disk associated with the USB flash drive. 

 CHAPTER – 6 Introduction to Word Processor 
1. What are the different methods to change margin in writer?  (J-2019) (J-2023)        

❖ Page margins are the white space around the top, bottom, left, and right of your document.  

❖ Changing or setting page margins in Open office writer can be done in two ways: 

❖ Using the Rulers -–quick and easy, but does not have precise values. 

❖ Using the Page Style dialog box – can specify precise values for the margins. 

1.Changing page margins -–using Ruler: 

❖ The shaded sections of the rulers are the margins. 

❖ Hold the mouse pointer over the line between the gray and white sections. 

❖ The mouse pointer turns into a double headed arrow. 

❖ Hold down the left mouse button and drag the mouse to move the margin and release it at the required point. 

❖ The new margin is set. 

2.Using the Page Style dialog box: 

❖ To change margins using the Page Style dialog box 
❖ Right-click anywhere on the page and select Page from the popup menu and select page tab of page style dialog box. 

❖ In the Margins boxes, specify the values for left, right, top and bottom margins. 

❖ Click on ok button. 

2. What are Header and Footer? How do you insert page numbers? (S-2022)(M-2024) 

❖ The header is a section of the document that appears in the top margin, which displays the title or chapter 

name, author name of a document. 

❖ Select from the main menu Insert →Header →Default 

❖ The header text area is separated from the normal text area. 

❖ The footer is a section of the document that appears in the bottom margin of the page which displays the page 

number, date, time etc. which gets displayed on all the pages automatically. 

❖ Select from the main menu Insert → Footer →Default 

❖ Place the insertion pointer in the footer part of the page. 

❖ Select Insert →Fields→Date to insert date in all the pages. 

Inserting and Formatting page numbers:  

❖ The page numbers can be inserted by performing the following steps: 

❖ Place the insertion pointer where you want to insert the page number 

❖ Choose Insert → Fields → Page Numbe 

❖ The page number appears with a gray background  

Normally, the page numbers appear as 1,2,3….., To change the numbering style, the following sequence of 

steps can be performed: 

❖ Position the insertion pointer where the page number has to appear 

❖ Select Format → page, which will display the Page Style dialog box. 

❖ Select Page Tab 

❖ In the Layout settings, select the Format drop down combo box 

❖ Select the desired style and click OK button. 

3. Write the steps to Find and Replace a word with another word in Open Office writer?  (S-2021)(M-2023) 

1. Click Edit → Find & Replace (or) Ctrl + F.  

The Find & Replace dialog box appears. 

2. Type the text you want to find in the Search for box.  

To replace the text with different text, type the new text in the Replace with box. 

3. Click Find button, to start the search, the found word is highlighted.  

To replace text, click Replace button.  

The highlighted word is replaced with the word given in the Replace with box. 

4. Click Find All, Writer selects all instances of the search text in the document.  

Click Replace all button, Writer replaces all matches. 
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5. Enable Match case to perform the search case sensitively so that uppercase and lower cases are distinguished separately.  

Enable Whole Words only to make the search more specific to words. 

4. Write the steps to create the bullets and numbering in open office Writer. (M-2020) 

Bullets : 

❖ This is a paragraph level attribute that applies a bullet character to the start of the paragraph.  

❖ In bulleted lists, each paragraph begins with a bullet character. 

The style of bullets and numbering can be changed by applying the following steps: 

1.Select the text to be bulleted, 2.Format → Bullets and Numbering, 3.Select Bullets Tab 

4.The Bullets and Numbering dialog box appears where different styles of bullets are displayed 

5.Click on the required style, 6.Click Ok button, 7.The selected text is bulleted. 

Numbering: 

❖ This attribute applies a numeral to the start of the paragraph.  

❖ Numbering is more suitable when the text has to be presented as a sequence. 

To apply Numbering: 

1.Select the text to be numbered, 2.Format → Bullets and Numbering, 3.Select Numbering Type Tab 

4.The Bullets and Numbering dialog box appears where different styles of numbering are displayed 

5.Click on the particular style,  6.Click Ok button 7.The selected text is numbered. 

5. Parts of Writer Window: (J-2019) 

1.Title Bar:  
❖ The title bar is displayed at the top of the window, which displays the name of the document and its application.  

❖ By default, the document is given the name as Untitled1.  

Control Buttons: 

❖ At the right corner of title bar the control buttons available: (1) minimize, (2) maximize/restore and (3) close 

2. Menu Bar : 

❖ The menu bar is below the title bar which comprises of various menus consisting of various options. 

1. File -–ew, Open, Close, Save, Save As, Print, Export etc.  

2. Edit –cut, copy, paste, Undo, Redo   

3. View –Toolbars, web layout, print layout, navigator etc.  

4. Insert –Inserting various elements such as pictures, tables, charts, comments, headers, footers.  

5. Format – Page size, layout, font characteristics, bullets and numbering etc.  

6. Tables–To create a table, insert rows, insert columns, split cells, merge cells etc.  

7. Tools –Spell check, macros, mail merge, end notes/footnotes etc.  

8. Window –New Window, Close Windows, Split and Freeze.  

9. Help – The Help menu displays the inbuilt help features in Open Office. 

3.Tool Bar:  

• 1.Standard Tool Bar: Cut, Copy, Paste, Undo etc…  

• 2.Formatting Tool Bar: Bold, Underline, Italics, Font type, Font color etc 

• Ruler :  (1) Horizontal ruler and (2) Vertical ruler. 

4.Work Space : 

❖ The work space is the blank area which is used to type the content of the file. 

❖ A flashing vertical bar that appears at the beginning of the screen which is called as “Insertion pointer”.  

5.Status Bar:  

❖ The status bar is at the bottom of the window which shows the current status of the document such as number 

of pages, current page number, default language etc.  

6. Selection using other methods: 

To select the text using mouse: 

i) Move the insertion pointer to the beginning of the text 

ii) Hold down the Left mouse button and drag it across the text 

iii) Release the mouse button when the required portion of text is selected  

iv) The selected text will be highlighted. 

Selection using Keyboard:+ 

To select the text using keyboard: 

i) Move the insertion pointer to the beginning of the text 

ii) Hold the Shift key and use the movement keys to drag across the required portion. 

iii) when the required portion is selected release the Shift key  

iv) The selected text will be highlighted. 

Selection using Shortcut keys: 

❖ Shortcut keys help to select the text quickly and easily. 

❖ To select a word -–Double click on the word 

❖ To select the entire document -–Press Ctrl + A 
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7. Write any 10 shortcut keys and their actions in open office writer. (S-2020) 

KEY ACTION 

→ To move a character right 

← To move a character left 

↑ To move one line up 

↓ To move one line down 

Ctrl + → One word right 

Ctrl + ← One word left  

Ctrl + ↑ One paragraph up 

Ctrl + ↓ One paragraph down 

Home To the beginning of line 

End To the end of line 

Ctrl + Home To the beginning of document 

Ctrl + End To the end of document 

Tab To move one cell to right 

Shift + Tab To move one cell to left 

Pg up(Page Up) To scroll one screen up 

Pg Down(Page Down) To scroll one screen down 
 

8. Explain auto spell check option (M-2022) 

Auto Spell Check:  

❖ Auto Spell Check option checks each word as it is typed and displays a wavy red line under any misspelled 

word. Once the word is corrected, the red wavy line disappears.  

❖ This can be done by clicking the Auto Spellcheck icon  

❖ Right-click on a word with a wavy underline, to open a powerful context menu.  

❖ Correct words can be selected from the suggested words on the menu.  

❖ The selection will replace the misspelled word with correct word.  
❖ To perform a separate spelling check on the document (or a text selection) click the Spelling and Grammar icon  

❖ This checks the document or selection and opens the Spelling dialog box (Figure 6.31) if any misspelled words are found.  

❖ This can also be achieved by pressing F7 key. 

Here are some more features of the spelling command:  

❖ Not in Dictionary text area displays the misspelled word Suggestions box displays alternate spellings.  

❖ Ignore once button is to skip the word once, Ignore All button skip all occurrences of the word. 

❖ Change button will change only that particular occurrence.  

❖ Change All button will change all occurrences of the word.  

❖ The text language can be changed (for example, Spanish, French, or German) from the Spelling dialog box. 
❖ C The new words can be added to a dictionary. Click Add in the Spelling dialog box and pick the dictionary to add it to. 

 CHAPTER -7 Working with Open Office Calc 
1. Explain about changing the column width in Calc. (M-2023)                         

Method-I 

❖ Select the columns whose width is to be changed. 

❖ Choose Format→Column→Width option. 

❖ Column Width dialog box appears. 

❖ Enter the amount in Width spin box and click OK. 

Method-II 

❖ Right click at the column lable whose width is to be changed. 

❖ Choose Column Width from the popup menu. 

❖ Column Width dialog box appears. 

❖ Enter the amount in Width spin box and click OK. 

2. Write the steps to generate the following series. 5, 10, 20 ….. 2560   (S-2021)(J-2023)                             B 

❖ Select the required number of cells to generate the series.                                                                    5                                           

❖ Click Edit→Fill, the fill series dialog box appears show below.                                                         10 

❖ Select the direction as Down in fill series dialog box.                                                                         20 

❖ Select the Series type Growth.                                                                                                             40 

❖ Initial value of the series 5 should be typed in start value box                                                            80 

❖ Maximum value of the series 2560 should be typed in End value box                                             160 

❖ The value should be typed in increment box                                                                                     320 

❖ Click ok .Now the series is generated as given below                                                                       640   

                                        1280 

                                                                                                                                                                  2560 

3. Parts of the Open Office Calc Window: (J-2019) 

1.Title Bar:  

❖ Top of the window is called the “Title Bar”.  

❖ It is used to show the name of the file and name of the application.  

❖ In Open Office calc, the default name for the first unsaved worksheet is “Untitled1”.  

❖ When you save the file, Untitled will change to the name in which you saved. 
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2.Control Buttons:  

❖ In the right corner of title bar, (1) minimize, (2) maximize / restore and (3) close control buttons are available. 

3.Menu Bar  

❖ Below the title bar is menu bar. Most of the menus are very similar to what you learnt in Open Office Writer.  

❖ File- Create a new file, Open an existing file, Close the current file, Save a file, Save a file in another name, 

print file, Export file etc.  

❖ Edit - cut, copy, paste, Undo, Redo, Fill etc.,  

❖ View - used to modify the environment of calc.  

❖ Insert –cells, columns, rows, functions, charts etc.,  

❖ Format –text and cell formatting features.  

❖ Tools –spell check, protect document, insert pictures, macros, etc.,  

❖ Data –sort, filter, subtotal, validity etc.,  

❖ Window –New Window, Close Windows, Split and Freeze.  

❖ Help – menu lists in-built help features available with Open Office. 

4.Tools Bar: 

❖ Standard Toolbar –New Open Save, Send, print, print preview, Cut, Copy, Paste, Sorting, inserting chart etc.,  

❖ Formatting Toolbar –Changing font style, font size, font colour, alignments, cell formatting etc.,  

❖ Formula bar –Name box, Function Wizard, Sum button, Function button and Input 

5.Scroll bar :(1) Vertical Scrollbar and (2) Horizontal Scrollbar  

6. Row, Column, Cell and Cell Pointer: 
❖ The worksheet has number of rows and columns, where each column is labelled as A, B, C, D ….. AA, AB, AC ….. 

❖ Column heading starts from A and end with AMJ.  

❖ In the case of Microsoft Excel 2016, there are 16,384 columns (A to XFD) and 10,48,576 rows available. 

❖ Intersection of each row and column makes a box which is called as “Cell”.  

❖ Cell pointer is a rectangle box which can be moved around the worksheet.  

❖ The cell in which the cell pointer is currently located is known as “Active cell”. 

4. Operators: (J-2019) 

(1) Arithmetic Operators, (2) Relational Operators  (3) Reference Operators (4) Text Operator 

1. Arithmetic Operators  

❖ Arithmetic operators are symbols for performing simple arithmetic operations such as addition, subtraction, 

multiplication, division etc.,  

❖ These operators return a numerical result.  

Operator  Name Value in 

Column B 

Value in 

Column C 

Formula in 

Column D 

Result in Column D 

Operator 

+ Addition 98 25 = B3 + C3 123 

- Subtraction 125 25 = B3 – C3 100 

* Multiplication 25 5 = B3 * C3 125 

/ Division 90 10 = B3 / C3 9 

^ Exponent 25 2 = B3 ^ C3 625 

% Percent 600   = B3 * 35% 72 

Percentage (%) operator shows percentage of the content. 

2. Relational Operators  

❖ Relational operators are symbols used for comparing two values such as greater than, less than, equal to etc.  

❖ The relational operators are also called as "Comparative operators". 

❖ These operators return either a True or a False. 

3.Reference Operator  

❖ Reference operators are used to refer cell ranges.  

❖ A continuous group of cells is called as “Range”.  

❖ There are three types of reference operators that are used to refer cells in calc; they are 

❖  (1) Range Reference Operator, (2) Range Concatenation (3) Intersection Operator. 

1. Range Reference Operator : Syntax: reference left : reference right 

2. Reference concatenation operator:  Syntax: reference left ~ reference right 

3. Intersection Operator:  reference left ! reference right 

4. Text Operator: 

❖ In Calc, “&” is a text operator which is used to combine two or more text.  

❖ Joining two different texts is also known as “Text Concatenation” 

5. Explain filters in open office calc (J-2023) 

Filtering: 

❖ Filter is a way of limiting the information that appears on screen.  

❖ Filters are a feature for displaying and browsing a selected list or subset of data from a worksheet. 

Types: 1.AutoFilter, 2. Standard Filter 3.Advanced Filter. 

1.Auto Filter:  

❖ Auto Filter applies a drop-down list box to each field (columns) filled with similar data available in that field.  
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❖ Using the list box item, you can filter the data that matches the criteria of the data concerned.  

Using Auto Filter: 

• Click Auto Filter icon available on the “Standard tool bar” (or) click Data → Filter → Auto Filter 

• The list box contains similar data in the fields. 

• Each list box item will be considered as filter criteria. 

Removing Auto Filter: 

• To remove auto filter, click “Auto filter” icon once again. 

• The original table is displayed without filter. 

2.Standard Filter:  
❖ Auto filter is used only for single criteria on a data, whereas the Standard filter is used for multiple criteria to filter. 

Step 1: Select Data → Filter → Standard Filter. 

           Now, the entire data is selected and "Standard Filter" dialog box dispalys. 

Step 2: Select the column heading from the “Field name” list box for first criteria. 

            Select conditional opeator such as >, <, = etc., from “Condition” list box. 

            Type or select the value of critera in the “Value” box. 

Step 3: Select the one of the logical operator (And / Or) from “Operator” list box to fix second criteria. 

            Follow the step 2, for the next criteria. 

Step 4: Click “OK” to finish. 

 CHAPTER- 8 Presentation Basics 
1 Define Slide sorter view and write its significance. (M-2023) 

❖ Slide Sorter view shows a thumbnail of each slide in order.  
❖ Use this view to rearrange the order of slides, produce a timed slide show, or add transitions between selected slides. 

Significance: 

❖ Check View → Toolbars → Slide View to show the Slide view toolbar. 

❖ Adjust the number of slides (up to a maximum of 15). 
❖ After you have adjusted the number of slides per row, View → Toolbars →Slide View will remove this toolbar from view. 

❖ Use the Control (Ctrl) key: Click on the first slide and, while pressing Control, select the other desired slides. 

2. How many types of views are provided by impress to its users? Explain them. (M-2019)(S-2020) 

1.Normal view: 

❖ Normal view is the main view for creating individual slides. 

❖ Use this view to format and design slides and to add text, graphics and animation effects.  

2. Outline view: 

❖ Outline view shows topic titles, bulleted lists and numbered lists for each slide in outline format.  

❖ Use this view to rearrange the order of slides, edit titles and headings, rearrange the order of items in a list and 

add new slides.  

3. Notes view:  

❖ Notes view lets you add notes to each slide that are not seen when the presentation is shown.  

4. Slide Sorter view:  

❖ Slide Sorter view shows a thumbnail of each slide in order.  
❖ Use this view to rearrange the order of slides, produce a timed slide show, or add transitions between selected slides.  

5. Handout view:  

❖ Handout view lets you print your slides for a handout.  

❖ You can choose one, two, three, four, or six slides per page from Tasks pane → Layouts. 

❖ Thumbnails can be re-arranged in this view by dragging and dropping them. 

 CHAPTER- 9 Introduction to Internet and Email 
1. Explain any five types of internet services. (S-2021)(S-2022)                                        

1.Wireless:  

❖ Radio frequency bands are used in place of telephone or cable networks.  

❖ One of the greatest advantages of wireless Internet connections is the "always-on" connection that can be 

accessed from any location that falls within network coverage.  
❖ Wireless connections are made possible through the use of a modem, which picks up Internet signals and sends them to other devices. 

2.Mobile:  

❖ Many cell phone and smartphone providers offer voice plans with Internet access.  

❖ Mobile Internet connections provide good speeds and allow you to access the Internet.  

3.Hotspots:  

❖ Hotspots are sites that offer Internet access over a wireless local area network (WLAN) by way of a router that 

then connects to an Internet service provider. 

❖ Hotspots utilize Wi-Fi technology, which allows electronic devices to connect to the Internet or exchange data 

wirelessly through radio waves.  

❖ Hotspots can be phone-based or free-standing, commercial or free to the public. 

4.Broadband:  

❖ This high-speed Internet connection is provided through either cable or telephone companies.  
❖ One of the fastest options available, broadband Internet uses multiple data channels to send large quantities of information.  

❖ The term broadband is shorthand for broad bandwidth.  
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❖ Broadband Internet connections such as DSL and cable are considered high-bandwidth connections.  

❖ Although many DSL connections can be considered broadband, not all broadband connections are DSL.  

5.DSL: 

❖ DSL, which stands for Digital Subscriber Line, uses existing 2-wire copper telephone line connected to one's 

home so service is delivered at the same time as landline telephone service.  

❖ Customers can still place calls while surfing the Internet. 

6.Cable:  

❖ Cable Internet connection is a form of broadband access.  

❖ Through use of a cable modem, users can access the Internet over cable TV lines.  

❖ Cable modems can provide extremely fast access to the Internet. 

7.Satellite: 

❖ In certain areas where broadband connection is not yet offered, a satellite Internet option may be available.  

❖ Similar to wireless access, satellite connection utilizes a modem. 

8.ISDN:  

❖ ISDN (Integrated Services Digital Network) allows users to send data, voice and video content over digital 

telephone lines or standard telephone wires. 

❖ The installation of an ISDN adapter is required at both ends of the transmission—on the part of the user as well 

as the Internet access provider. 

9.Dongles / Data Card:  

❖ Today, many dongles provide wireless capabilities.  

❖ For example, USB Wi-Fi adapters are often called dongles.  
❖ Since most computers now have built-in Wi-Fi chips, mobile data adapters, such as 3G and 4G dongles, are more prevalent.  

❖ These types of dongles allows to connect to the Internet even when Wi-Fi is not available. 

2. Explain any five internet applications with suitable examples. (M-2019)(S-2020)(M-2023) 

1. Job search : 

❖ Nowadays, many people search for their jobs online using naukri.com, monster.com, recuritmentindia.com etc 

as it is quicker. 

2.Online Shopping : 

❖ The internet has also facilitated the introduction of a new market concept consisting of virtual shops.  

❖ For example amazon.com 

3.Stock market updates : 

❖ Selling or buying shares sitting on computer through internet.  

❖ Several websites like ndtvprofit.com, moneypore.com, provide information regarding investment. 

4.Travel : 

❖ One can use internet to gather information about various tourist place. 

❖ It can be used for booking Holiday tours.  

❖ Some of the web sites providing this service are goibibo.com, makemytrip.com, olacabs.com. 

5. Research : 

❖ Research papers are present online which helps in the researcher doing a literature review 

6. Video conferencing : 

❖ It enables direct face-to-face communication across networks via web cameras, microphones, and other 

communication tools.  

7. E –commerce : 

❖ E–commerce (electronic commerce or EC) is the buying and selling of goods and services, or the transmitting 

of funds or data, Largest e-commerce companies in India are Flip kart, Snap deal, Amazon India, Paytm. 

8. Online payments : 
❖ The rising boom of online payments in India has given way to many new entrants in the industry such as Paytm etc  

9. Social Networking : 
❖ Social networking is the use of internet-based social media programs to make connections with friends, family etc.  

❖ Examples of social networking includes Facebook 

10. e-banking : 

❖ E-banking (Online banking) , also known as internet banking, it is an electronic payment system that enables 

customers of a bank or other financial institution to conduct a range of financial transactions through the 

financial institution's website. 

3. Explain the dos and don’ts of safe surfing on internet. 

1.Don’t give out your personal information : 

❖ Don’t put personal details such as your home address, telephone numbers or parent’s work address online as 

cybercriminals can use this information to create a fake profile with your details 

2.What goes online, stays online :  

❖ Use privacy settings to make sure only your friends and family can see photos you post. 

❖ Avoid posting holiday plans as criminals have been known to track your movements 

3.Check your security and privacy settings  : 

❖ Make sure your social network privacy settings are secured so only your friends can see your personal 

information and use your privacy settings to restrict who can see your posts, videos and photos 
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4.Password safety: 

❖ Sharing your password with your parents is a sensible idea, but avoid sharing your password with your friends, 

even if they promise they won’t tell anyone! Also, when setting your password, make sure it isn’t something 

people may guess such as your pet’s name.  

❖ Use a mixture of letters, numbers and upper and lower case characters 

5.Always protect your mobile device: 

❖ Make sure your mobile phone is pin-protected so all your personal information stored on it is safe.  
❖ Download a security app which allows you to remotely wipe any personal data, should your mobile be lost or stolen 

6.Don’t talk to strangers online or offline : 

❖ Don’t meet up with strangers and let your parents know if a stranger has tried to get in contact with you online. 

7.Listen to the adults who know : 

❖ Adults will always be worried about you.  

❖ Help set their mind at rest and avoid chatting online with strangers.  

8.Be wary of unsecured or unknown websites: 

❖ When shopping online, use reputable and known retailers. 

9.Be careful what links you click on : 

❖ Avoid clicking links in an email, Instant Message or on your social network unless you are sure the message is 

from someone you know. 

4. Explain the different types of interactions in E-governance (J-2019) 

E-governance: 

❖ Electronic governance or e-governance is the application of information and communication technology (ICT) 

for delivering government services.  

Four types: 

Government to citizens(G2C),               Government to Business (G2B),  

Government to Government(G2G) and Government to employees (G2E) 

Benefits of E-governance 

1.Reduced corruption      

2.High transparency   

3.Increased convenience   

4. Reduction in overall cost. 

5. Expanded reach of government. 

5. Explain structure of E-mail (J-2022) 

Structure of email: 

❖ Click the Compose button and then writing an e-mail content requires. 

When sending an e-mail message, several fields are required to be filled: 

❖ The To field is where you type the e-mail address of the person who is the recipient of your message. 

❖ The From field should contain your e-mail address. 

❖ If you are replying to a message, the To and From fields are automatically filled out; if it's a new message, 

you'll need to enter them manually. 

❖ The Subject should consist of a few words describing the e-mail's contents. The Subject lets the recipient see 

what the e-mail is about, without opening and reading the full e-mail. This field is optional. 

❖ The CC (Carbon Copy) field allows you to specify recipients who are not direct addressees (listed in the "To" 

field). This field is optional. 

❖ The BCC (Blind Carbon Copy) field is similar to CC, except the recipients are secret. Each BCC recipient 

will receive the e-mail, but will not see who else received a copy. The addressees (anyone listed in the "To" 

field) remain visible to all recipients. This field is optional. 

❖ Finally, the Message Body is the location you type your main message. It often contains your signature at 

the bottom; similar to a hand-written letter. 

 CHAPTER- 10 HTML - Structural Tags 
1. Explain various heading level tags in HTML? (S-2021)(M-2022) 

❖ Headings are used to include titles to sections of a web page.  

❖ HTML has six levels of headings viz. <h1> to <h6>.  

❖ The number with h indicates the level of heading. Header tags display the body text as bolder and larger in size 

according to its level.  

The syntax of heading tags:   <h…> Heading text </h…> 

Example : 

<html>  

<head>  

<title> Heading </title> 

</head> 

<body>  

<h1> Welcome to Computer Application</h1>  

<h2> Welcome to Computer Application</h2>  
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<h3> Welcome to Computer Application</h3>  

<h4> Welcome to Computer Application</h4>  

<h5> Welcome to Computer Application</h5>  

<h6> Welcome to Computer Application</h6> 

</body> 

</html> 

 CHAPTER- 11 HTML - Formatting text, Creating Tables, List and Links 
1. Explain the attributes used with <table> tag in HTML.  (M-2019)(S-2022) (J-2024) 

❖ The <table> is a container tag.  

❖ There are several attributes to improve the layout of the table.  

❖ They are listed below: 

Cell spacing:  

❖ It is used to set the space between cells in a table. The value should be in pixels  

Cell padding:  

❖ It is used to set the space between the contents of a cell and its border.  

❖ The value should be in pixels. 

Border:  

❖ Border attribute with <table> tag is used to specify the thickness of the border lines around the table.  

❖ The value of the border attribute should be a non zero value in pixels.  

❖ If its value is zero, HTML displays the table without border.  

❖ The default value is Zero in most the browsers.  

Border color:  

❖ It is used to apply the colour to the border lines. 

Align:  

❖ It is used to set the position of the table within the browser window.  

❖ Left is the default position.  

❖ Right or center may be the value of align attribute. 

BG color : 

❖ It is used to apply background colour to the table.  

Height and Width:  

❖ These two attributes are used to specify the height and width of a table in terms of pixels or percentage. 

Example:  

<table Cellspacing = 3 cellpadding = 10 border = 1 bordercolor=green align=center bgcolour = pink width = 70%> 

2. Explain the types of list with suitable HTML code.   (M-2019) (S-2021)(M-2022)(M-2023) 

1.Numbered List / Ordered List : 

❖ Numbered list is created within the tag pair <OL> ….. </OL> tag.  

❖ The tag <LI> is used to present the list item in the list. Ordered list displays items in a numerical or 

alphabetical order.  

❖ Both <OL> and <LI> tags are container tags.  

❖ But the usual the practice, closing tag </LI> never be used. 

Attributes of Ordered List: 

(1) Type - changing numbering style     (2) Start - changing numbering order 

2.Un-numbered List / Unordered List:  

❖ Unordered lists are often referred as bulleted lists.  

❖ Instead of numbers, each element in the list has prefixed with a special bullet symbol.  

❖ Unordered list is surrounded within <UL> ……… </UL> tags.  

❖ As discussed above, each list element is defined by <LI> tag. 

3.Definition List : 

❖ Definition list is different from other two types of list. No bullet or number is provided for the list items.  

❖ In this list type, the list element has two parts.  

❖ (1) A definition term       (2) The definition description 

❖ Definition list is surrounded within <DL> ……. </DL> tags.  

❖ Definition term is presented in between <DT> ….. </DT> tag and  

❖ Definition description should be surrounded within <DD> ………… </DD>  tag. 

4.Nested Lists:  

❖ A list block can be defined inside another list is called as nested list. 

3. What is Link and explain the types of links. (J-2019)(M-2024) 

Links:  

❖ Link is an important feature of HTML to connect web resources. 

❖ Link in HTML is used to create hyperlinks to web content. 

❖ Make connection with a part of content of same document or an external document. 

There are two important things needs to create a link in HTML,  

         (1) The name of the file or URL to which you want to link  

www.Padasalai.Net                                                  www.TrbTnpsc.com

Kindly Send Me Your Study Materials To Us Email ID:   padasalai.net@gmail.com

PadasalaiPadasalai

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m
https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m


42 

                     PREPARED BY...,    B.MOHAMED YOUSUF M.C.A., B.Ed..,    (PG ASST IN COMPUTER SCIENCE) 

                        [yousufaslan5855@gmail.com] 

         (2) The text that will serve as the clickable link.  

❖ The anchor tag <A> is used to create links along with HREF attribute.  

❖ HREF is abbreviated as “Hypertext Reference”.  

Structure of an anchor tag with href: 

<A href = “ Web content path / URL “> Text – Clickable link </A> 

1.Internal Links: 

❖ Creating a link to a particular section of the same document is known as Internal Link.  

❖ To create an internal like, the attribute Name is used along with <A> tag.  

❖ The Name attribute of <A> tag establish the link to the content within the document. 

2.External Link:  

❖ Establish link with an external web page in known as external linking.  
❖ It is made possible by providing the URL of the external file in the HREF attribute of <A> tag of the current page. 

4. Write an HTML code  to  create the following table (M-2019)(M-2020) 

Class Boys Girls 

XI 75 80 

XII 65 70 

<html> 

<head> 

<title> Table </title> 

</head> 

<body> 

<table border = 11> 

<TR>  

<TH> Class </TH>  

<TH> Boys </TH>  

<TH> Girls </TH> 

</TR> 

<TR>  

<TH> XI </TH>  

<TH> 75 </TH>  

<TH> 80 </TH> 

</TR> 

<TR>  

<TH> XII </TH>  

<TH> 65 </TH>  

<TH> 70 </TH> 

</TR> 

</table></body></html> 

5. Write an HTML code  to  create the following table (S-2020) 

Reg:No Total % 

1531 360 60% 

1532 420 70% 

<html> 

<head> 

<title> Table </title> 

</head> 

<body bgcolor =”paleGoldenRod”> 

<Table border = 1> 

<caption> Marks and percentage </caption> 

<TR> 

<TH> Registration No </TH> 

<TH> Total </TH> 

<TH> Percentage </TH> 

</TR> 

<TR>  

<TD> 1531 </TD>  

<TD> 360 </TD>  

<TD> 60% </TD> 

</TR> 

<TR>  

<TD> 1532 </TD>  

<TD> 420 </TD>  
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<TD> 70% </TD> 

</TR> 

</table> 

</body> 

</html> 

6. Write the output of the following html code (J-2019) 

<html>                                                                  OUTPUT 

<head>                                                              INPUT DEVICES 

<title> Nested List </title>                                  Keyboard 

</head>                                                                Mouse 

<body>                                                                 Light pen 

<OL>  

<LI> INPUT DEVICES                                    OUTPUT DEVICES 

<UL type=Disc>                                                    Monitor 

<LI> Keyboard                                                       Printer 

<LI> Mouse                                                            Speaker 

<LI> Light pen  

</UL>  

<LI> OUTPUT DEVICES 

<UL type=Disc>  

<LI> Monitor 

<LI> Printer 

<LI> Speaker 

</UL>  

</OL> 

</body> 

</html> 

7. Write short note on  1) <strong> 2.<em> 3. <mark> 4. <hr> 5. <sub>  (M-2022) 

a) <strong> Important text : 

1. The <strong> tag is a phrase tag. 2. It is used to define important text by displaying text as bold. 

b) <em> - Emphasized text: 

1. The <em> tag is used to emphasize the text.  2. That means, when you use this tag, the text will be in italics. 

c) <mark> Tag: 

❖ The <mark> tag is used to highlight the text in HTML.  

❖ This is also a container tag.  

❖ Whatever the text given between <mark> and </mark> will be displayed as highlighting with default color 

(mostly yellow). 

d) <hr> tag: 

The <hr> tag having four attributes viz. size, width, no shade and color. 

1. Size:          Thickness of the horizontal line can be changed with size attribute.  

                         The size is given in terms of pixels.  

2. Width:       The width attribute specifies the horizontal width of the rule line. 

3. Noshade:   The default view of a horizontal rule line is 3D.  

4. Color: The horizontal line is displayed in gray color by default.  

Syntax:         <hr size=valuewidth=valuenoshade, color=color_name/code> 

e) <sub> tag: 

❖ In HTML, the <sub> and <sup> tags are used to create subscript and superscripts respectively.  

❖ As like as other formatting tags, this is also a container tag. 

 CHAPTER- 12 HTML - Adding multimedia elements and Forms 
1. Explain the <form>tag with its attributes (M-2019)                                  

1.Method: 
❖ The method attribute of the form tag is used to identify how the form element names and values will be sent to the server. 

❖ The get method will append the names of the form elements and their values to the URL. 

2.Action: 

❖ The action attribute identifies the server side program or script that will process the form.  

❖ The action will be the name of a Common Gateway Interface (CGI) program written in programming 

languages like Perl, JavaScript, PHP or Active Server Pages (ASP). 

General Format of <form> tag: 

<Form method=get/post action= “back_end_server_script”> Form elements 

</Form> 
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2. Explain Input tag with attributes (J-2019) (J-2024) 

<Input> Tag  

❖ Most of the form controls are created by using <input> tag.  
❖ The <input> is an empty tag used to create different form elements or controls such as text box, radio buttons so on.  

Attributes of <input> tag: 

1.Type:This attribute is used define the type of control to be created by <input> tag. 

2.Name: This attribute of <input> tag is used to assign a name to the input controls.  

3.Value: This attribute is used to define default value to some controls. 

4.Size: This is used to set the width of the input text in terms of characters.  

             It is applicable only for textbox and password boxes. 

5.Maxlength: This attribute of <input> tag is used to set the length of the input character (number of 

                       characters to be input) to the textbox and password boxes. 

3. How will you insert images with HTML document? (S-2022) 

Inserting Images with HTML document: 

❖ The <IMG> tag along with the attribute src (Source) is used to add images in HTML document.  

General format: 

<img src = image_name_with_extension>  (OR)  <img src = URL> 

Example: <img src = image1.gif>  

❖ Src attribute is the main attribute used to specify the file name of the image to be inserted.  

❖ If the image is not in the current working folder, the image file name should clearly specify with the path of the 

file or URL, where the file is available. 

Example: <img src = “D:\images\animals\cat.jpeg”> 

An HTML code to insert an inline image 
<html> 

<head> 

<title> Inserting Images </title> 

</head> 

<body>  

<h1 align = center> Bharathiyar </h1>  

<img src = bharathiyar.gif> 

</body> 

</html> 

 CHAPTER- 13 CSS - Cascading Style Sheets 
1. List and explain the Font and text element properties and values used CSS. (M-2020)(J-2022) 

Formatting Properties Values Example 

 

 

 

1.Text Colour 

 

 

 

Color 

 

 

 

Predefined_Color_Name 

P 

{ 

color:pink; 

} H1 

{ 

color : MediumSeaGreen; 

} 

 

2.Text Alignment 

 

Text-align 

 

Center / Left / Right / Justify 

P 

{ 

Text-align : center; 

} 

 

3.Font type 

 

Font-family 

 

Font_name 

P 

{ 

Font-family : “Times New Roman”; 

} 

 

 

4.Font Style 

 

 

Font-style 

 

 

Normal / Italic 

P 

{ 

Font-family : “Times New Roman”; Font-style : 

Italic; 

} 

 

 

5.Font Style 

(Bold) 

 

 

Font-weight 

 

 

Normal / Bold 

P 

{ 

Font-family : “Times New Roman”; Font-style : 

Italic; 

Font-weight : bold; 

} 
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6.Font size 

 

 

Font-size 

 

 

Size in pixels 

P 

{ 

Font-family : “Times New Roman”; Font-style : 

Italic; 

Font-size : 14px; 

} 

 

7.Backgroud 

Colour 

 

Background 

Colour 

 

Predefined_Color_Name 

Body 

{ 

background-color : violet; 

} 

 

8.Border Colour 

 

Border 

Border thickness 

<space> border style 

<space>Predefined_border    

Color_Name 

 

H2 { border : 2px solid red; } 

 CHAPTER- 14 Introduction to Java script 
1. Explain about the popup dialog boxes in JavaScript   (S-2021) (J-2023)(M-2024)                 

❖ JavaScript supports three important types of dialog boxes.  

❖ Dialog boxes are also called as Popup Boxes.  

❖ These dialog boxes can be used to raise an alert, or to get confirmation on any input or to have a kind of input 

from the users.  

❖ JavaScript supports three kind of popup boxes: Alert box, Confirm box, and Prompt box. 

1.Alert Dialog Box:  

❖ An alert dialog box is mostly used to give a warning message to the users.  

❖ For example, if one input field requires to enter some text but the user does not provide any input, then as a 

part of validation, you can use an alert box to give a warning message.  

❖ Alert box gives only one button "OK" to select and proceed.  

The syntax of alert box is  

                  Alert(“Message”);   (or)   Window.alert(“Message”);  

Example:  

                  alert(“Name is compulsory entry”);   (or)  window.alert(“Name is compulsory entry”); 

2.Confirm Dialog Box:  

❖ A confirmation dialog box is mostly used to take user's consent on any option. 

❖ It displays a dialog box with two buttons: OK and Cancel. 

❖ If the user clicks on the OK button, the confirm() will return true.  

❖ If the user clicks on the Cancel button, then confirm() returns false. 

The syntax of confirm dialog box is  

                  confirm(“message”);  (or)   window.confirm(“message”); 

Example:  

                    confirm(“Hai Do you want to continue:”);  

3.Prompt Dialog Box:  

❖ The prompt dialog box is very useful when the user want to pop-up a text box to get user input.  

❖ Thus, it enables you to interact with the user.  

❖ The user needs to fill in the text box field and then click OK.  

❖ The prompt dialog box is displayed using a method called prompt() which takes two parameters: 

❖ a label which you want to display in the text box   

❖ a default string to display in the text box. 

The Syntax of prompt dialog box is,  

                           Prompt(“Message”,”defaultValue”);  

Example:  

                        prompt(“Enter Your Name:”,”Name”);  

2. Explain about the Arithmetic operator with suitable example.  (M-2020)(M-2022) (J-2024) 

Arithmetic Operators : 

❖ JavaScript supports all the basic arithmetic operators like addition (+), subtraction (–), multiplication (*), 

division (/), and modulus (%, also known as the remainder operator). 

Arithmetic Meaning Example Result 

+ Addition var sum = 20 + 120 Variable sum = 140 

- Subtraction var diff = 20 – 120 Variable diff = 100 

* Multiplication var prod = 10 * 100 Variable prod = 1000 

/ Division var res = 100/522 Variable res = 5.22 

% Modulus operator var rem = 100 % 522 Variable rem = 22 (remainder) 

 

 

   

www.Padasalai.Net                                                  www.TrbTnpsc.com

Kindly Send Me Your Study Materials To Us Email ID:   padasalai.net@gmail.com

PadasalaiPadasalai

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m
https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m


46 

                     PREPARED BY...,    B.MOHAMED YOUSUF M.C.A., B.Ed..,    (PG ASST IN COMPUTER SCIENCE) 

                        [yousufaslan5855@gmail.com] 

Example Coding: 

<Html> 

<Head>  

<Title>Demo Program – To test Arithmetic Operators in JavaScript </Title> 

</Head> 

<Body>  

<script language="javascript" type="text/javascript"> 

var value1 = 522, value2=10;  

document.write("<br>Data1 : "+value1);  

document.write("<br>Data2 : "+value2);  

var sum = value1+value2;  

var diff = value1-value2;  

var prod = value1*value2;  

var res = value1/value2;  

var rem = value1%value2;  

document.write("<br><br>The Sum of Data1 and Data2 : "+sum);  

document.write("<br>The Difference of Data1 and Data2 : "+diff);  

document.write("<br>The Product of Data1 and Data2 : "+prod);  

document.write("<br>The Result after Division of Data1 and Data2 : "+res);  

document.write("<br>The Remainder after Division of Data1 and Data2 : "+rem); 

</script> 

</Body> 

</Html> 

3. Explain relational operator suitable example. (M-2023) 

❖ Relational operators are also called as Comparison operators, they compares two values and the result is true or false. 

Relational (Comparison) 
Operator 

Meaning Example Result 

Assume x=10 and y=20 

== Equality x==y False 

!= In-equality x!=y True 

< Less-than x<y True 

> Greater-than x>y False 

<= Less-than or equal to x<=y True 

>= Greater-than or equal to x>=y False  
 

4. Write a rules of naming variables in Java script program (J-2019) (J-2023) 

1. The first character must be a letter or an underscore (_).  

Number cannot be as the first character.  

2. The rest of the variable name can include any letter, any number, or the underscore.  

You can't use any other characters, including spaces, symbols, and punctuation marks. 

3. JavaScript variable names are case sensitive.  
That is, a variable named Register Number is treated as an entirely different variable than one named register number. 

4. There is no limit to the length of the variable name. 

5. JavaScript's reserved words cannot be used as a variable name.  

All programming languages have a supply of words that are used internally by the language and that cannot be 

used for variable names.  

5. Explain Logical operator with suitable example  (S-2022) 

Logical operator: 

❖ Logical operators perform logical (boolean) operations. Logical operators combine or invert Boolean values.  

❖ Once comparisons are made, the logical operators && (AND), || (OR) and ! (NOT) can be used to create more 

complex conditions. 

Logical Operator Example  Meaning Result 

&& ((4>5(&& )10<5)) 

((expr1) && (expr2)) 

(Logical AND) Returns true if expr1 and expr2 

both true.  

True 

|| ((4>5(|| )10<5)) 

((expr1) || (expr2)) 

(Logical OR) Returns true if either expr1 or 

expr2 is true, or both are true. 

True 

! !(10<5) 

!(expr1) 

(Logical NOT) Returns true if expr1 is false; 

otherwise, returns false. 

False  

Usage :  
❖ For && (AND) the result is false if the first operand is false; otherwise, the result is the Boolean value of the second operand. 

❖ For || (OR) the result is true if the first operand is true; otherwise, the result is the Boolean value of the second operand. 

❖ For ! (NOT) the result is true if the operand is false; otherwise, the result is true. 
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 CHAPTER- 15 Control Structure in Java script 
1. Explain for loop with example    (J-2019)(M-2023)                                                           

❖ The for loop is a very rigid structure that loops for a pre-set number of times.  

❖ In JavaScript for structure is very flexible, which makes this type is very useful.  

The syntax of the for loop : 

      for(initialization; condition; increment/decrement)  

      {  

         Body of the loop;  

       }  

❖ The for structure within parenthesis there are three parts each separated by semicolon.  

❖ They are, 

❖ The first part of the loop initialize a variable which is also called as control variable.  

❖ In most case the control variable is declared as well as initialized. 

❖ The second part is the conditional statement that determines how many times the loop will be iterated. 

❖ The third and final part determines how the value of control variable is changed (Incremented/Decremented)  

Example:                                                                                    Output 

<html>                                                                                        Please enter Table You want :3                                                                     

<head>                                                                                        3x3=0 

<Title> Program - To test for statement in JavaScript </Title>  3x1=3 

</head>                                                                                       3x2=6 

<body>                                                                                        3x3=9 

<script language="javascript" type="text/javascript">               4x3=12 

var no1 = prompt("Please enter Table You want :", "0");           5x3=15 

document.write("<h2> Multiplication for your need </h2>");  

for( var m=0;m<=10;m++) 

{  

document.write(no1+" x "+m+" = "+n*m+"<br>"); 

} 

</script> 

</body>  

</html> 

2. Explain switch case statement with example (M-2019)(S-2021)(S-2022) (J-2024) 

❖ Java Scripts offers the switch statement as an alternate to using if...else structure.  

❖ The switch statement is especially useful when testing all the possible results of an expression.  

The syntax of a switch structure: 

switch(expression) 

{ 

case label 1:  

       statements1;  

       break;  

case label 2:  

       statements2;  

       break;  

 case label n;  

      statements - N;  

      break;  

default:  

      statements; 

} 
❖ The switch statement begins by evaluating an expression placed between parenthesis, much like the if statement.  

❖ The result compared to labels associated with case structure that follow the switch statement.  

❖ If the result is equal to a label, the statements in the corresponding case structure are executed.  

❖ The default structure is can be at the end of a switch structure if the result of the expression that do not match 

any of the case labels. 

Example : 

switch(grade)  

{  

case 1:  

     document.write("Your Grade is Outstanding..");  

     break;  

case 2:  

     document.write("Your Grade is Excellent..");  

     break;  
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case 3:  

     document.write("Your Grade is Good..");  

     break;  

case 4:  

      document.write("Your Grade is Satisfectory..");  

      break;  

default:  

        document.write("Your Grade Poor and have to re-appear Exam..");  

}  

3. Write a Java Script program using while statement to display 10 numbers. (S-2020) 

<Html>  

<Head>  

<Title> Displaying Numbers</title>  

<Head>  

<Body>  

<script language= "java Script" type = "text/ javaScript">  

var start = prompt ("Enter the start value:", "0" );  

var end = prompt ("Enter the end value:", "10" );  

var inc = prompt ("Enter the increment value:", "1" );  

document.write ("<h2> The numbers are</h2>")  

while (start <= end)  

{  

document.write (start + "<br>”);  

start = start + inc;  

}  

</script>  

</body>  

</Html> 

4. Explain while loop and example. (J-2020) 

While loop : 

❖ In JavaScript while loop is another most basic loop.  
❖ The purpose of a while loop is to execute a statement /block of statement repeatedly as long as an expression is true.  

❖ The while statement creates a loop that executes a specified statement as long as the test condition evaluates to true.  

❖ The condition is evaluated before executing the statement. 

The syntax is:  

while (condition)  

{  

body of the loop  

} 

Example: 

while(no2<=5) 

{  

document.write(no2+" ");  

no2=no2+1; } 

❖ To execute a while statement, the interpreter first evaluates expression.  

❖ If the value of the expression is true the interpreter executes the statement and repeats, jumping back to the top 

of the loop and evaluating expression again 

 CHAPTER- 16 JavaScript Functions 
1. Describe any five pre-defined functions in JavaScript with examples (M-2019) 

Function Description Example Result 

toUpperCase() Used to convert given string into uppercase  x=”java” 

x.toUpperCase(); 

JAVA 

toLowerCase() Used to convert given string into lowercase x=”JAVA” 

x.toLowerCase(); 

java 

length Used to find length of the given string x=”JAVA” 

x.length(); 

4 

parseInt() Used to convert the given float value into an integer parseInt(34.234); 34 

parseFloat() Used to convert the given string into a integer parseInt(“34.23”); 34.23 
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 CHAPTER – 17 Computer Ethics and Cyber Security 

1. What are the various crimes happening using computer?  (M-2022) (J-2024)           

1. Cyber Terrorism:  

❖ Hacking, threats, and blackmailing towards a business or a person.  

2. Cyber stalking:  

❖ Harassing through online.  

3. Malware:  

❖ Malicious programs that can perform a variety of functions including stealing, encrypting or deleting sensitive 

data, altering or hijacking core computing functions and monitoring user’s computer activity without their 

permission.  

4. Denial of service attack:  

❖ Overloading a system with fake requests so that it cannot serve normal legitimate requests.  

5. Fraud:  

❖ Manipulating data, for example changing the banking records to transfer money to an unauthorized account.  

6. Harvesting:  

❖ A person or program collects login and password information from a legitimate user to illegally gain access to 

others’ account(s).  

7. Identity theft:  

❖ It is a crime where the criminals impersonate individuals, usually for financial gain.  

8. Intellectual property theft:  

❖ Stealing practical or conceptual information developed by another person or company.  

9. Salami slicing:  

❖ Stealing tiny amounts of money from each transaction.  

10. Scam:  

❖ Tricking people into believing something that is not true.  

11. Spam:  

❖ Distribute unwanted e-mail to a large number of internet users.  

12. Spoofing:  

❖ It is a malicious practice in which communication is send from unknown source disguised as a source known 

to the receiver.  

3. Write the different types of cyber-attacks. (J-2019) (M-2023) (J-2023) 

Cyber Attack                            Function 

Virus ❖ A virus is a small piece of computer code that can repeat itself and spreads from one 

computer to another by attaching itself to another computer file.  

❖ One of the most common virus is Trojan.  

❖ A Trojan virus is a program that appears to perform one function but actually performs 

malicious activity when executed. 

Malware ❖ Malware is a type of software designed through which the criminals gain illegal access to 

software and cause damage.  

Worms ❖ Worms are self- repeating and do not require a computer program to attach themselves.  

❖ Worms continually look for vulnerabilities and report back to the author of the worm when 

weaknesses are discovered. 

Spyware ❖ Spyware can be installed on the computer automatically when the attachments are open, by 

clicking on links or by downloading infected software. 

Ransom 

ware 

❖ Ransom ware is a type of malicious program that demands payment after launching a cyber-

attack on a computer system.  

❖ This type of malware has become increasingly popular among criminals and costs the 

organizations millions each year.  

Pharming ❖ Pharming is a scamming practice in which malicious code is installed on a personal computer 

or server, misdirecting users to fraudulent web sites without their knowledge or permission. 

Phishing ❖ Phishing is a type of computer crime used to attack, steal user data, including login name, 

password and credit card numbers. 
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PUBLIC EXAMINATIONS COMPULSORY QUESTIONS WITH answers  [MARCH-2019 TO JULY-2024] 

 TWO MARKS: (Q.NO 24) 

1.  Write the output of the following HTML code.  (J-2024) 

<html>                                                                                    OUTPUT 

<head>                                                                                    Tamil 

<title> Number List </title>                                                   Telugu 

</head>                                                                                   English 

<body>                                                                                    Computer Applications                           

<OL>                                                                                       Commerce                     

   <LI> Tamil                                                                           Accountancy                                                

   <LI> Telugu                                                                          Economics 

   <LI> English                                                                          

   <LI> Computer Applications 

   <LI> Commerce 

   <LI> Accountancy 

   <LI> Economics 

</OL> 

</body> 

</html> 

2.  What is cyber-crime? (M-2024) 

❖ A cyber-crime is a crime which involves computer and network. 

❖ Cyber-crime is an intellectual, white-collar crime. 

❖ Those who commit such crimes generally manipulate the computer system in an intelligent manner. 

3.  Convert  (1560)8  into equivalent Decimal number  (J-2023) 

Weight 512 64 8 1 

Positional 

Notation 

83 82 81 80 

Given  

number 

1 5 6 0 

                                                                       

(1560)8 = 512x1+64x5+8x6+1x5 

             = 512+320+48+0 

(1560)8 = (880)10 

4.  What is meant by signed magnitude? (M-2023) 

❖ The simplest method to represent negative binary numbers is called Signed Magnitude. 

5.  What are the guidelines to be followed by any computer user? (S-2022) 

1.Honesty :  

❖ Users should be truthful while using the internet. 

2.Confidentiality:  

❖ Users should not share any important information with unauthorized people. 

3.Respect :  

❖ Each user should respect the privacy of other users.  

4.Professionalism:  

❖ Each user should maintain professional conduct. 

5.Obey The Law:  

❖ Users should strictly obey the cyber law in computer usage. 

6.Responsibility: 

❖ Each user should take ownership and responsibility for their actions. 

6.  Convert (65)10 into Binary number  (S-2021)(M-2022) 

2  65      LSB 

2  32-1           (46)10  = (1000001)2 

2  16-0 

2  8-0 

2  4-0 

    2-0     

    1-0     MSB 

7.  What are the two types of encryption? (S-2020) 

❖ Encryption is the process of translating the plain text data (plaintext) into random and mangled data (called cipher-text). 

❖ For example data being transferred via networks (e.g. the Internet, ecommerce), mobile telephones, wireless 

microphones, wireless intercom systems, Bluetooth devices and bank automatic teller machines.. 

8.  Write any four common library functions (M-2020) 

1.isNaN( ), 2.toUpperCase( ), 3.toLowerCase( ), 4.length( ), 5.alert( ), 6.prompt( ),    7.write( ) 
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9.  Write the formula to find the sum of the contents of the cells A1,A2 and A3 in a worksheet (J-2019) 

 =A1+A2+A3 (Add the values in cells A1,A2 and A3) 

10.  Write about short cut keys for LEFT,RIGHT, CENTER AND JUSTIFIED alignments.  (M-2019) 

1.LEFT       -  Ctrl +L    2.RIGHT        –   Ctrl +R  3.CENTER -   Ctrl +E   4.JUSTIFIED -    Ctrl +J 

 THREE MARKS: (Q.NO. 33) 

1.  A) Add : 10112+10012   B) Subtract : 10010102-101002      (J-2024) 

A) Add : 10112+10012    

1 1 1  

     1 0 1 1 

     1 0 0 1 

 1  0 1 0 0 

  

10112+10012  = 101002 

 

 

B) Subtract : 10010102-101002       

  1 10  10   

 10 0 0 1  0 0 1 0 

   1 0 1 0 0 

  1 1 0 1 1 0 

10010102-101002     = 1101102 

2.  Add: (A)  -2010 + 2510  (M-2024) 

Step:1                                          Step:2                                           Step:3 

2 20       -20   = 10100                  2 25       25    = 11001                     -20  = 11101100 

2 10-0   8bit = 00010100            2 12-1      8bit  = 00011001               25 = 00011001 

2 5-0     1s = 11101011               2 6-0 

2 2-1                           1                2 3-0                                                  -5 =1000001012   

   1-0      2s= 11101100                    1-1                                                       [-2010 + 2510 = -510=1000001012 ] 

(B) 2210 + 1510        

Step:1                                          Step:2                                           Step:3 

2 22       22  = 10110                     2 15         15      = 1111                  22 = 00010110 

2 11-0    8bit = 00010110             2 7-1         8bit   = 00001111          15 = 00001111 

2 5-1                                              2  3-1                      

   2-1                                              1-1                                                   37 = 001001012        

   1-0                                                                                                      [2210 + 1510 = 3710=001001012 ] 

3.  What is indenting text in writer? Write its types (J-2023) 

Indenting text: 

❖ Indent is the distance from the left and right margin of a paragraph.  
❖ It is used to improve the efficiency and readability of the paragraph and makes the paragraph look more attractive. 

There are four types of indentations:  

• Left Indent   • Right Indent   • First Line Indent  • Hanging Indent. 
4.  Compare CUT-PASTE and COPY- PASTE (M-2023) 

CUT and PASTE: 

 To move a file or folder, first select the file or folder and then choose one of the following: 

❖ Click on the Edit → Cut or Ctrl + X or right click → Cut from the pop-up menu. 

❖ To move the file(s) or folder(s) in the new location, navigate to the new location and paste it using Click Edit 

→ Paste or Ctrl + V or Right click → Paste from the popup menu.  

❖ The file will be pasted in the new location. 

COPY and PASTE:  

To copy a file or folder, first select the file or folder and then choose one of the following: 

❖ Click Edit → Copy or Ctrl + C or right click→ Copy from the pop-up menu. 

❖ To paste the file(s) or folder(s) in the new location, navigate to the target location and paste it using Click 

Edit → Paste or Ctrl + V or Right click → Paste from the popup menu.  

❖ The file will be pasted in the new location 

5.  What are the uses of <strong> and <em> tag? (S-2022) 

1.<strong> Important text: 

The <strong> tag is a phrase tag. It is used to define important text. This tag displays the text as bold.  

2.<em> - Emphasized text:  

The <em> tag is used to emphasize the text. That means, when you use this tag, the text will be in italics. 
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6.  Describe any three pre-defined functions in JavaScript with examples (M-2022) 

Function Description Example Result 

toUpperCase() Used to convert given string into uppercase  x=”java” 

x.toUpperCase(); 

JAVA 

toLowerCase() Used to convert given string into lowercase x=”JAVA” 

x.toLowerCase(); 

java 

length Used to find length of the given string x=”JAVA” x.length(); 4 

parseInt() Used to convert the given float value into an integer parseInt(34.234); 34 

parseFloat() Used to convert the given string into a integer parseInt(“34.23”); 34.23 
 

7.  Write the syntax for  else-if statement. (S-2021) 

If (condition 1)  

{  block 1; }  

else if (condition 2)  

{  block 2; }  

else if (condition 3)  

{ block 3; }  

else  

{ block 4;} 

8.  Define – Unicode (S-2020) 

❖ Unicode is an encoding system, designed to handle various world languages, including Tamil.  

❖ Its first version 1.0.0 was introduced in October 1991. 

❖ Unicode is the best suitable to handle Tamil. 

9.  What is the decimal equivalent sequence for (547)8 octal sequence? (M-2020) 

(547)8   = 5x82+4x81+7x80 

             =5x64+4x8+7x1 

             =320+32+7 

             =(359)10 

10.  What message will be displayed, if the input marks is given as 60, for the following snippet. (J-2019)   
if (marks> = 40 )                                                    Message will be display like, 

{                                                                                    you have passed  

alert (“you have passed”}         

}                                                                           

else                                                            

alert (“you have failed”);  

 } 

11.  Write an HTML code to scroll the following message in a web page. (M-2019) 

“Welcome to HTML” 

<html> 

<head> 

<title> Marguee </title> 

</head> 

<body> 

<marguee > Welcome to HTML </marquee> 

</body> 

</html> 
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